# Table of Contents

**Need Help?**

- Linked Text

**Menu Index**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>8</td>
</tr>
<tr>
<td>New</td>
<td>9</td>
</tr>
<tr>
<td>Open</td>
<td>9</td>
</tr>
<tr>
<td>Save</td>
<td>10</td>
</tr>
<tr>
<td>Save As</td>
<td>10</td>
</tr>
<tr>
<td>Print</td>
<td>11</td>
</tr>
<tr>
<td>Export PDF</td>
<td>12</td>
</tr>
<tr>
<td>DXF Out</td>
<td>12</td>
</tr>
<tr>
<td>DXF In</td>
<td>12</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>13</td>
</tr>
<tr>
<td>Undo</td>
<td>14</td>
</tr>
<tr>
<td>Redo</td>
<td>15</td>
</tr>
<tr>
<td>Select</td>
<td>15</td>
</tr>
<tr>
<td>Select All</td>
<td>15</td>
</tr>
<tr>
<td>Cut</td>
<td>16</td>
</tr>
<tr>
<td>Copy</td>
<td>16</td>
</tr>
<tr>
<td>Paste</td>
<td>17</td>
</tr>
<tr>
<td>Delete</td>
<td>17</td>
</tr>
<tr>
<td>Import Link</td>
<td>18</td>
</tr>
<tr>
<td>Export Link</td>
<td>18</td>
</tr>
<tr>
<td>Edit Links</td>
<td>19</td>
</tr>
<tr>
<td>Screen Capture</td>
<td>20</td>
</tr>
<tr>
<td>Erase Background</td>
<td>20</td>
</tr>
<tr>
<td>Group Selected Lines/Arcs</td>
<td>20</td>
</tr>
<tr>
<td><strong>Sketch</strong></td>
<td>21</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Point</td>
<td>21</td>
</tr>
<tr>
<td>Line</td>
<td>22</td>
</tr>
<tr>
<td>Fillet</td>
<td>22</td>
</tr>
<tr>
<td>Arc</td>
<td>22</td>
</tr>
<tr>
<td>Ungroup Selected Lines/Arcs</td>
<td>23</td>
</tr>
<tr>
<td>Circle</td>
<td>23</td>
</tr>
<tr>
<td>Construction Line</td>
<td>23</td>
</tr>
<tr>
<td>Annotation</td>
<td>23</td>
</tr>
<tr>
<td>Dimension</td>
<td>25</td>
</tr>
<tr>
<td>Line Length</td>
<td>26</td>
</tr>
<tr>
<td>Parallel Distance</td>
<td>26</td>
</tr>
<tr>
<td>Line to Point</td>
<td>27</td>
</tr>
<tr>
<td>Point to Point</td>
<td>27</td>
</tr>
<tr>
<td>Angle</td>
<td>27</td>
</tr>
<tr>
<td>Radius</td>
<td>28</td>
</tr>
<tr>
<td>Tangent</td>
<td>28</td>
</tr>
<tr>
<td>Point on Line</td>
<td>28</td>
</tr>
<tr>
<td>Point on Circle</td>
<td>28</td>
</tr>
<tr>
<td>Automatic</td>
<td>29</td>
</tr>
<tr>
<td>Constrain</td>
<td>29</td>
</tr>
<tr>
<td>Same Line</td>
<td>29</td>
</tr>
<tr>
<td>Same Point</td>
<td>30</td>
</tr>
<tr>
<td>Fix Point / Line</td>
<td>30</td>
</tr>
<tr>
<td>Horizontal</td>
<td>31</td>
</tr>
<tr>
<td>Vertical</td>
<td>31</td>
</tr>
<tr>
<td>View</td>
<td>32</td>
</tr>
<tr>
<td>Move</td>
<td>32</td>
</tr>
<tr>
<td>Rotate</td>
<td>33</td>
</tr>
<tr>
<td>Zoom Box</td>
<td>33</td>
</tr>
<tr>
<td>Zoom Min / Max</td>
<td>34</td>
</tr>
</tbody>
</table>
Attributes
Info
Measure
Pen
Font
Analysis
Add Load
Add Actuator
Add Stops
Edit Stops
Resultant Force / Torque
Stress
Shear / Bending Moment
Force on Pin
Derive Accelerations
Dynamic Simulation
New Simulation
Edit Simulation
Tolerance Zone
Tolerance Trace
Toolbar Help
New Features
Index
Need Help?

There are many ways to get help with Analytix.

Your installation comes with Analytix Manual and Analytix Tutorial, in PDF format suitable for creating a hard copy.

Inside the Analytix Help system you can:

- Use the search tool to find all topics based on a key word, such as "Force Elements".
- Browse through help with the Previous, and Next buttons. This will step you through the help subtopics in a logical sequence.
- You can click on colored text to get more information.

**Tool Tips:**
When you move the cursor over any icon on the screen, the name of the icon appears briefly below the cursor.

**Linked Text**

Some words in the program's Help system are highlighted and underlined. When you place the cursor over this text, the cursor becomes the hand symbol. This text indicates a link to more information on the subject. Click the text to jump to the related help page.

**Menu Index**

**File**

The File menu contains options to let you create a New file, Open an existing one, save the current drawing as a file, and Print the current drawing. It also contains functions to read and write DXF files.

**Edit**

The Edit menu lets you Select portions of your drawing. It also lets you Cut, Copy or Paste selected portions of the drawing.

**Sketch**

The Sketch menu contains all the commands to let you sketch drawing entities: Points, Lines, Arcs, Fillets, Circles, and Construction Lines are all here.

**Dimension**

The Dimension menu is where you can add dimensions to your sketch in order to convert it into a scale drawing.

**Constrain**
The Constrain menu contains options which allow you to specify which point and line of the drawing will stay fixed in any motion or statics problem. Further menu options allow you to specify line segments in the sketch as being portions of the same lines, and specify circles to be concentric.

**View**

The View menu lets you move or rotate selected portions of the drawing, it lets you zoom in or out, it lets you blank or unblank portions of the drawing and do level management.

**Defaults**

The Defaults menu lets you set default pen colors and styles, set default unit types, set default tolerances and specify whether tolerance analysis is to be statistical or absolute.

**Tools**

The Tools menu contains functions which let you animate your drawing, create an Envelope of it, or Trace the curve followed by a given point. It also has tools for creating Graphs and Tables of values of interest, a Calculator and Equation Solver.

**Attributes**

The Attributes menu lets you view the various attributes of all the drawing entities and dimensions in the drawing. It lets you change whichever attributes are appropriate to change. There is also a function which lets you measure distances and angles from the drawing.

**Analysis**

The Analysis menu lets you add loads to the drawing, derive reaction forces and tolerance zones.

**File**

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open...</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save As...</td>
<td></td>
</tr>
<tr>
<td>Recent</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Export PDF</td>
<td></td>
</tr>
<tr>
<td>DXF Out</td>
<td></td>
</tr>
<tr>
<td>DXF In</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

The **File** menu contains options which perform a number of disk and printer/plotter related tasks: reading and writing drawings to disk, reading and writing DXF files for communication with CAD
systems, and plotting.

For more information, see
New
Open
Save
Save As
Plot
Export PDF
DXF Out
DWF In

**New**

The **File** / **New** menu option creates a new file with no name and no contents. Erases the current drawing.

If your current file has not been saved you will be asked whether you wish to save it before it is erased.

**Open**

The **File** / **Open** menu option allows you to open a previously saved Analytix file.

Analytix presents you with the **File** dialog box. It contains a file list box which will initially be filled with all the files with a .ax extension (the default Analytix extension). The dialog box also contains a file entry area, where the name of the file to be loaded may be typed in.

To select one of the files in the directory, click on the file name. Notice that this name will be echoed in the filename box.
Alternatively the file name may be typed directly into the filename box.

When the correct file name has been entered, click **Open**, or press the **enter** key.

**Save**

The **File / Save** menu option saves the current drawing in a file with the current name. If the current drawing is untitled you will be prompted to give the file a name in a similar way to the **Save as** option.

**Save As**

The **File / Save As** menu option prompts you for the name of the file in which the current geometry is to be saved.

A file is then created with the given name. If no file extension is given, the default extension '.ax' is used.
Print

Menu option **File / Print** brings up the standard system **Print** dialog box so you can choose a printer and print options.
Analytix will scale the drawing to best fit your page.

**Export PDF**

This renders the currently visible part of the display to pdf format. Just select the path and fill in the file name in the PDF Export window.

**DXF Out**

This option lets you output geometry as a DXF file. This facilitates transfer between Analytix and other CAD programs.

The standard **Save As** dialog box appears to enter the name of the DXF file. Ax adds the default extension .DXF if you omit extension.

Only geometry entities are saved in DXF files. Dimensions are not saved.

**DXF In**

This option lets you read in DXF files created in other CAD systems.

When you select this option, you will see the same file selection box which appears with the **File / Open** menu option. This time files with the extension .DXF will be preselected in the File list.
To read in a DXF file, select or type in the name and click on the Open button.

The current release of Analytix is only able to read geometric information from DXF files, and not dimensions.

In DXF files dimensions are regarded as ornaments and the geometry is defined by the drawing. In Analytix the dimensions are the things which define the geometry. This difference in outlook explains the fact that the DXF files are not rich enough to preserve a full dimension driven geometry description.

If you are importing a correctly sized part from a CAD system, and do not care how it is to be dimensioned, you can have Analytix automatically dimension the part using the Dimension/Automatic option.

Note that if your DXF file contains more than 350 entities, you will not be able to read it into Analytix. It is best to keep the size of Analytix files moderate to avoid excessive degradation of the system's performance.

**Edit**

<table>
<thead>
<tr>
<th>Selection Options</th>
<th>Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Y</td>
</tr>
<tr>
<td>Select</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Geometry</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Dimensions</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Force Elements</td>
<td></td>
</tr>
<tr>
<td>Annotations</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
<tr>
<td>Import Link...</td>
<td></td>
</tr>
<tr>
<td>Export Link...</td>
<td></td>
</tr>
<tr>
<td>Edit Links...</td>
<td></td>
</tr>
<tr>
<td>Screen Capture...</td>
<td></td>
</tr>
<tr>
<td>Erase Background</td>
<td></td>
</tr>
<tr>
<td>Group Selected Lines/Arcs</td>
<td></td>
</tr>
<tr>
<td>Ungroup Selected Lines/Arcs</td>
<td></td>
</tr>
</tbody>
</table>

The **Edit** menu contains the Selection options, which are used to select which entities certain
operations will be performed upon.

The Edit menu also contains the standard Cut, Copy, Paste operations, the Undo and Redo functions, Erase Background. The Group Selected... allows Analytix to display mass properties of the selected profile.

For more information, see

Undo
Select
Select all
  Geometry
  Dimensions
  Force Elements
  Annotations
Cut
Copy
Paste
Import Link
Export Link
Edit Links
Screen Capture
Erase Background
Group Selected Lines/Arcs
Ungroup Selected Lines/Arcs

Undo

When a sketch is consistently dimensioned, Analytix automatically converts this dimensioned sketch into a scaled drawing. If the sketch and the dimensions are too far out of line with each other, the results of this process can be a little confusing. It can turn out that the scaled drawing does not look like the intended picture.

At this stage, the Undo option is available and will return you to the sketch before Analytix redrew it. You can now remedy the situation either by altering the sketch (using the Move, Rotate, and Select-then-drag options) or by altering one or more dimension values.

Use one of these methods:

1. Click the Undo button on the toolbar.
2. Hold the [Ctrl] key and press [Z].
3. Select the Edit menu, and choose Undo.
Redo

Redo reinstates actions that you have undone.

Use one of these methods:

1. Click the Redo button on the toolbar.
2. Hold the [Ctrl] key and press [Y].
3. Select the Edit menu, and choose Redo.

If there are no actions to redo, the Redo option will be grayed.

You can redo as many actions as you have undone. Performing a new action clears the list of undone actions that were saved to redo.

Select

This option is used to select entities in the drawing. Selected entities can then have one of a number of operations performed upon them. They can be Cut, Copied, Blanked, Moved, Rotated, and, depending on the type of the selected entities, a variety of more specialized functions may be performed.

Many of the menu items are "grayed out" and unpickable unless some entities (sometimes of a specific type or combination of types) are selected. Examples are the Cut and Copy options in the Edit menu, which become active only when some entities are currently selected. A more complicated example is the Attributes / Measure option which is only active when either a pair of points, a pair of lines, or a line and a point are selected.

Selecting a Single Entity

To select a single entity, position the cursor over that entity and click with the left mouse button.

Selecting Multiple Entities

To select multiple entities, hold down the [SHIFT] key when you click on the entity to be selected. Then the previously selected entities are not unselected and the entity you click on is added to their number.

Select All

The Edit / Select All menu option selects all the entities in the current drawing. Both blanked and unblanked entities are selected.

Keyboard Shortcut:

Press [Ctrl] + A.

Geometry

This option selects all the points, lines, arcs and circles in the current drawing. Dimensions are not selected. Both blanked and unblanked entities are selected.
Keyboard Shortcut:
Press [Control] + G.

Dimensions
This option selects all the dimensions in the current drawing. Geometric entities are not selected. Both blanked and unblanked entities are selected.

Keyboard Shortcut:
Press [Control] + D.

Force Elements
This option selects all the force elements in the current drawing. Applied forces and torques, springs dampers and actuators are all selected. Both blanked and unblanked entities are selected.

Annotations
This option selects all the annotations in the current drawing. Both blanked and unblanked entities are selected.

Cut
This option Cuts the currently selected entities and any dependent entities from the drawing. These entities are then pasted onto the clipboard.

What is removed
All the currently selected entities are removed from the drawing. In addition, any dimensions, applied torques or forces which refer to any of the selected entities are removed.

Keyboard Shortcut:
Press [Ctrl] + [X].

Copy
This option copies all currently selected entities to the clipboard. Any entities which depend on unselected entities are not copied.

The selected entities are not removed from the drawing.

What appears on the Clipboard
All the selected entities appear on the clipboard in metafile format. This format may be pasted into a number of different Microsoft Windows applications.

Copy also puts an Analytix format description of the selected entities on the Clipboard.

Any entities which are dependent on entities which were not Copied are not placed on the
clipboard.

When a line, circle, or arc is put on the clipboard, endpoints and centers for those entities are also put on the clipboard.

**Keyboard Shortcut:**

Press [Ctrl] + [C].

To copy an area of the drawing as a bitmap, see Screen Capture below.

**Paste**

If you have previously Cut or Copied an Analytix drawing to the clipboard, this option allows you to Paste that drawing onto your current drawing.

**Paste** is “Grayed out” unless the clipboard contains a drawing in Analytix format. This drawing may have been Cut or Copied from the current Analytix window, or from a separate Analytix window.

When you pick **Paste**, the entities in the clipboard will be added to your current drawing. The pasted entities will then become the currently selected entities. They will be positioned in the same coordinate position they were Cut or Copied from. This can be a little confusing under certain circumstances:

1. If the entities are pasted outside the current screen window - then you will not immediately see them. You can use **Zoom max / min** from the **View** menu to see the whole picture.
2. If the entities have just been Copied from the same window - then the new copy will be pasted on top of the old ones. You can use **View / Move** to move the new copy so you can see it.

It is important to note that Cutting an entity then Pasting it back in does not necessarily give you the same object you started with because of the additional entities which are added to the clipboard along with selected entities.

For example, if you cut one edge of a triangle, the line and a pair of end points are put on the clipboard. However the line's end points are not removed from the drawing as they are necessary to define the ends of the other lines of the triangle. When you Paste the line back in, both the line and its new endpoints are pasted. Thus the line is no longer attached to the rest of the triangle and may be Moved away from it. To reattach the line you would need to use the **Same Point** constraint.

**Keyboard Shortcut:**

Press [Ctrl] + [V].

**Delete**

Deletes the currently selected object(s).

**Keyboard Shortcut:**
Press [Delete].

**Import Link**

This option lets you set up a Dynamic Data Exchange (DDE) link which feeds data into Analytix from another program running under Windows (or from another copy of Analytix running under Windows).

*Edit / Import Link* is selectable only if there is a Link currently on the Clipboard. Hence, before selecting this option, you must ensure that a link is present on the clipboard. How this is done depends on which program you are linking to Analytix.

If you are creating a link from another copy of Analytix, you do this using *Edit / Export Link*.

When you select *Import Link*, you see the Import Link dialog box.

![Import Link dialog box](image)

Use this box to specify the name of the variable to which the imported values are to be given. This may be any legal variable name or the name of a dimension in our Analytix drawing.

**Export Link**

This option is used to export a Dynamic Data Exchange (DDE) link from Analytix to another program running under Windows (or to another copy of Analytix running under Windows).

When you select *Edit / Export Link*, you will see the Export Link dialog box.

![Export Link dialog box](image)

You may enter into this box any legal Analytix expression. Examples of such expressions are:

- 12.5
- x
- x^2-sin(theta)
- angle(LINE4,LINE6)

In order to create a working DDE link, after using *Edit / Export Link*, you then have to import the link from the clipboard into a second application (or second copy of Analytix). The command used for this depends on the application with which the link is being established. If you are creating a link with a second copy of Analytix, you use *Edit / Import Link* to complete the link.
Edit Links

This menu option lets you view the links which have been imported into Analytix. It also lets you temporarily or permanently disconnect the links.

When you select the option you see the Links dialog box.

This has a list of existing imported links, recorded in the following way:

Application | Topic | Item

Application is typically the name of the program where the link initiated.
Topic is typically the name of the current data file being handled by that program.
Item is typically the name of the individual piece of information which has been linked. If the link is with another copy of Analytix, the item is the expression which was exported. If the link is with Excel, the item is a spreadsheet cell identifier.

UnLink will temporarily disconnect a link. Select the appropriate link in the link list-box and press the button.

Link will establish the link the selected line item.

Link All will establish links to any unlinked items in the list if the corresponding file is open for editing.

Delete will permanently close the selected link and delete it from the list.

Edit will bring up the Edit Link dialog box. This is necessary if your Topic or Item information has changed, e.g. if you change the data file name or move a link in Excel to another row or column.

Note: you can only edit the row after it is Unlinked.
Change All Links Similarly is a checkbox in the Edit Link dialog box, used if you have several links all in the same file and you want to change file name. Make sure the renamed file is open for editing and all of the rows in the Links list are Unlinked. After making changes be sure to click OK to save the change and return to the Edit Link dialog where you can use Link All to reconnect your links.

Screen Capture

Allows part or all of the window to be copied to the clipboard as a bitmap image for pasting into other programs such as Word documents or Power Point presentations.

Erase Background

Traces and tolerance zones, when created, are placed on a background layer. Select Edit / Erase Background to erase this layer.

Group Selected Lines/Arcs

This option lets you create a group out of a set of lines arcs and circles. The main use of this feature is to define a profile in order to compute area and center of gravity.

To create a group, first select all the lines and arcs which are to be included (holding down the Shift key to select multiple entities).

The selected profile is now treated as a group. If you select one of the constituent entities, the whole group is selected.

To derive the area, select the group then select Attributes / Info or double click the group.
Create a drawing of an object in Analytix in two basic steps:

1. Sketch the appropriate shape of the object.
2. Add dimensions to specify the exact geometry of the object.

The commands in Sketch menu let you draw lines, arcs, circles, points, fillets and construction lines.

All the Sketch commands in Analytix are modes. This means that once you have picked, for example, Sketch / Line, you can continue sketching lines until you make another menu choice.

For more information, see
- Point
- Line
- Fillet
- Arc
- Circle
- Construction Line
- Annotation

Point

There are two types of points in an Analytix drawing

Implicit - these are created as a result of sketching a line, arc or circle. For example, if you draw a line, two implicit end points are defined.

Explicit - these points are created using the Sketch / Point menu option.

Explicit points are created using Sketch / Point, implicit points are created as a result of sketching other entities.

To create an explicit point:
1. Pick the **Sketch / Point** menu option or click on the Point button.
2. Position the cursor at the location where you want to place a point.
3. Click on the mouse button.

### Line

You sketch a line in Analytix as follows:

1. Choose **Sketch / Line** from the menu or click on the Line button.
2. Position the cursor at the place you wish your line to start.
3. Depress the left mouse button and, while keeping it depressed, drag the cursor to the place you wish the line to end.
4. When you have reached the line end point, release the mouse button.

### Fillet

You sketch a fillet in Analytix simply by clicking the mouse on the common endpoint of a pair of lines.

A fillet is really an arc tangent to each line whose endpoints match the endpoints of the lines.

The radius of the fillet sketched by Analytix is arbitrary, and chosen by the system to "look o.k."

The required fillet radius must be specified using the **Dimension / Radius** menu option.

Occasionally the addition of a fillet to an already consistently dimensioned figure will cause the figure to become over-dimensional. This is because adding a fillet adds three new dimensions to the system: a radius and two tangent dimensions. It is therefore best to draw fillets before completing the dimensioning of a figure.

### Arc

A circular arc is sketched in Analytix in the following way:

1. Choose **Sketch / Arc** from the menu or click on the Arc button.
2. Position the cursor on the screen where one end of the arc is to be located.
3. Press the left mouse button down and drag a chord to the position where the other end of the arc is to be located.
4. When the chord is correctly positioned, release the mouse button.
5. Move the cursor to a third point which should lie on the arc.
6. Depress the left mouse button and drag the arc into the desired shape.
7. When the desired arc shape is achieved, release the mouse button.

All arcs must have their radius dimensioned before a drawing may be consistently dimensioned.
Ungroup Selected Lines/Arcs

Groups are created in Analytix using the Edit / Group Selected Lines/Arcs menu option. Once a group is established, its constituent members may not be selected individually, they can only be selected all at once.

The Edit / Ungroup Selected Lines/Arcs menu option allows you to break up a group in order that its individual members may again be selected.

Select the group by clicking one of its members and choose Edit / Ungroup Selected Lines/Arcs.

Circle

Sketch a circle in Analytix as follows:

1. Choose Sketch / Circle from the menu or click on the Circle button.
2. Position the cursor at the place where you want the center of your circle to be.
3. Depress the left mouse button and drag the circumference of the circle.
4. When the radius of the circle looks right, release the mouse button.

All circles must have their radius dimensioned before a drawing may be consistently dimensioned.

Construction Line

In Analytix, a construction line differs from an ordinary line because it has no specific end points, rather it is automatically sized to overlap the current figure a little.

End points of construction lines may not be dimensioned. However the construction line itself may be dimensioned (using Angle, Distance Line to Point, or Parallel Distance).

Annotation

Annotation in Analytix can be positioned absolutely on the drawing, or relative to a point or a line in the drawing.

Absolute annotation stays at the specified location, even when the drawing moves.

Relative annotation, on the other hand maintains its position relative to the geometry when the geometry moves.

Annotations may include text; it may also include expressions or variables between @ symbols. For expressions, they are sent to the calculator and evaluated, then displayed. You can also use variables that were previously defined in the calculator. This lets you display analysis results as an annotation on the drawing.

Absolute Annotation

To create absolute annotation, select Sketch / Annotate, or click on the Annotation icon of the Toolbox.
An **Annotation** dialog box now appears.

Type the text of the annotation into this box. You may select to place a border round the annotation, or you may change the font of the annotation.

Once an annotation has been created, it may be selected and moved by clicking on it and dragging it. An annotation may be edited by selecting it then using the Attributes/Info menu option, or by double clicking on the annotation.

**Relative Annotation**

Annotation may be specified relative to a point, a line or a point and line.

Annotation relative to a point is equivalent to annotation relative to the point and a unit line in the x direction.

To specify relative annotation, first select the point, line or point and line to which you will attach the annotation. Then select **Sketch / Annotate** or the Annotation Icon in the Toolbox. Then click on the location of the screen where you want the annotation.

The Annotation dialog box appears. Type the text of the annotation in this box. You may also specify a border and a tag line.

The tag line joins the annotation to its referenced geometry.

**Expressions in Annotations**

Any expression which is typed between @ symbols in the text of the annotation will be evaluated by the calculator and the resulting number displayed on the screen.

For example if \( a \) is a variable in the calculator with a value of 2.5, the following annotation:

\[
\text{a} = @ a@ \\
\]

will be displayed as follows:

\[
\text{a} = 2.5 \\
\]

If DIMENSION23 has a reaction force of -1.275, the following annotation:

Reaction force is \(@ \text{react(DIMENSION23)}@\)

will be displayed:

Reaction force is -1.275

If POINT3 has coordinates (1.7,3.5), the following annotation:

\[
(@\text{xcoord(POINT3)}@,,@\text{ycoord(POINT3)}@) \\
\]

will be displayed:

(1.7,3.5)

While entering these expressions, you don’t have to type dimension or point names, you can click on them in the drawing and the selected entity will appear in the text box after the cursor.
Dimension

When you have entered a sketch into Analytix, the way to convert that sketch to a scale drawing is to add a consistent set of dimensions to the sketch. You do this using the **Dimension** menu.

A good analogy is with the way drawings were made before CAD. The engineer would communicate his design to the drafting department using a not-to-scale dimensioned sketch. The sketch indicates the overall shape of the object, but the dimensions give the draftsman the precise distances and angles to use. However, if there were either too many or too few dimensions to correctly define the part, it would come back from the draftsman for clarification.

Analytix works in a similar way

1. Sketch your part without worrying if your sketch is exactly right, but ensuring the sketch does in fact resemble the intended part.
2. Add dimensions to indicate the exact geometry.

Analytix will tell you whether your part is under dimensioned, consistently dimensioned, or has a redundant dimension. This appears in the status bar in the bottom left corner of the Analytix screen.

When the sketch is consistently dimensioned, Analytix will automatically produce a scale drawing from the dimensioned sketch representation.

While the sketch is under dimensioned, Analytix makes no attempt to alter the drawing to match the constraints already entered. It simply waits until it has a consistently dimensioned drawing. This is so that when it does come to create a scale drawing it has your original, unaltered sketch to work with.

If, however, you have entered all the dimensions you care about, you can ask Analytix to finish off the dimensioning for you using the **Dimension / Automatic** menu option. Analytix will create a consistent dimensioning scheme for your drawing which includes the dimensions which you have already specified.

After you enter the dimension, you can click-and-drag it to adjust its position on the screen.
For more information, see

- **Line Length**
- **Parallel Distance**
- **Line to Point**
- **Point to Point**
- **Angle**
- **Radius**
- **Tangent**
- **Point on Line**
- **Point on Circle**
- **Automatic**

### Line Length

The Line Length dimension lets you specify the length of a line.

To enter a line length dimension:

1. Choose the **Dimension / Line Length** menu option.
2. Position the cursor over the line to be dimensioned.
3. Press down on the left mouse button and drag the cursor away from the line. You will notice a dimension symbol following the cursor.
4. When the dimension symbol is in an appropriate place, release the mouse button.
5. Type in the dimension value in the **Dimension** entry box.
6. Complete the dimension value entry by clicking on the **Y** button, or by pressing the [ENTER] key.

Note that you cannot give a length dimension to a construction line, as the construction line has by definition no specific length.

### Parallel Distance

The parallel distance dimension specifies that two lines are parallel and it specifies their distance apart.

To make a Parallel Distance dimension:

1. Choose the **Dimension / Parallel Distance** menu option.
2. Click on the first line to be dimensioned.
3. Position the cursor over the second line to be dimensioned.
4. Press down on the left mouse button and drag the cursor away from the line. You will notice a dimension symbol following the cursor.
5. When the dimension symbol is in an appropriate place, release the mouse button.
6. Type in the dimension value in the **Dimension** entry box.
7. Complete the dimension value entry by clicking on the **Y** button, or by pressing the [ENTER] key.
Line to Point

This dimension lets you specify the perpendicular distance between a line and a point.

To make a Distance Line to Point dimension:
1. Choose the Dimension / Line to Point menu option.
2. Click either on the line or point to be dimensioned (or on the circumference of a circle or arc if its center point is to be dimensioned).
3. Position the cursor over the second entity to be dimensioned.
4. Press down on the left mouse button and drag the cursor. You will notice a dimension symbol following the cursor. When the dimension symbol is in an appropriate place, release the mouse button.
5. Type in the dimension value in the Dimension entry box.
6. Complete the dimension value entry by clicking on the Y button, or by pressing the [ENTER] key.

Point to Point

The Point to Point dimension lets you specify the distance between two points.

To make a Distance Point to Point dimension:
1. Choose the Dimension / Point to Point menu option.
2. Click one of the points to be dimensioned (or on the circumference of a circle or arc if its center point is to be dimensioned).
3. Position the cursor over the second point to be dimensioned (or on the circumference of a circle or arc if its center point is to be dimensioned).
4. Press down on the left mouse button and drag the cursor. You will notice a dimension symbol following the cursor.
5. When the dimension symbol is in an appropriate place, release the mouse button.
6. Type in the dimension value in the Dimension entry box.
7. Complete the dimension value entry by clicking on the Y button, or by pressing the [ENTER] key.

Angle

This lets you specify the angle between two lines. The lines do not need to share a common endpoint.

To make an Angle dimension:
1. Choose the Dimension / Angle menu option.
2. Click on the first line to be dimensioned.
3. Click on the second line to be dimensioned.
4. The angle dimension symbol will appear in either the acute or obtuse angle between the lines.
5. Type in the angle value in the **Dimension** entry box.
6. Complete the dimension value entry by clicking on the Y button, or by pressing the [ENTER] key.

**Radius**

This lets you specify the radius of an arc or circle.

In Analytix, all arcs, circles and fillets must be given an explicit radius.

To specify the radius of an arc or circle:
1. Position the cursor over the arc or circle.
2. Press the left mouse button and drag the dimension symbol to an appropriate position on the curve.
3. When the radius symbol is correctly placed, release the mouse button.
4. Type the radius value in the dimension entry box.
5. Click on the Y button or press [ENTER].

**Tangent**

This lets you specify that a circle or arc is tangent to a line or to another circle or arc.

To specify that two entities are tangent:
1. Click on the first entity (line, circle or arc).
2. Click on the second entity.

**Point on Line**

This lets you specify that a given point lies on a given line.

To specify a Point on Line constraint:
1. Select **Dimension / Point on Line**.
2. Click on the first point or line.
3. Click on the second line or point.

**Point on Circle**

This lets you specify that a given point lies on a given circle.

To specify a Point on Circle constraint:
1. Select **Dimension / Point on Circle**.
2. Click on the first point or circle.
3. Click on the second circle or point.
Automatic

This menu option tells Analytix to complete the dimensioning of the drawing itself.

This is a very powerful feature and is of particular use in these circumstances:

- When you do not know what else to dimension.
- When you have read in from file the correct geometry for a part and do not care how it is dimensioned.
- When you have entered all the dimensions you are currently concerned with and wish Analytix to fill in the rest.

There are many different ways to consistently dimension a given drawing. Analytix has a suite of heuristic algorithms which try to find "reasonable" dimensions to fill in. However there is no guarantee that the dimensions it uses are the ones which you want.

Analytix fills in a value for the dimensions which it creates by measuring from the sketch and scaling to make them match any dimensions which have already been entered. The value thus achieved is then rounded.

Constrain

The Constrain menu has options which let you constrain line segments to be collinear, circles and arcs to be concentric, and to set which point and line of the figure is to stay fixed.

For more information, see

- Same Line
- Same Point
- Fix Point
- Horizontal
- Vertical

Same Line

Sets the selected line segments to be collinear.

This option is grayed out unless the current set of selected entities comprises two or more lines.

To constrain a number of line segments to be collinear:

1. Make sure you are in Selection mode, either by picking Edit / Select from the menu or by
clicking the right mouse button.
2. Click on the first line to be constrained.
3. Holding down the shift key, click on the second line to be constrained.
4. Repeat step 3 for the rest of the lines to be constrained.
5. When the correct set of lines is selected, pick Constrain / Same Line.

If the addition of the Same Line constraint causes the drawing to be over dimensioned, then you will see the Redundant Dimension message. Otherwise the lines will be constrained to be collinear.

To remove a collinear constraint, you must delete the line, then redraw it.

**Same Point**

Sets the currently selected points and/or circle centers to be identical.

This option is grayed out unless the current set of selected entities comprises two or more points, arc or circle centers.

To constrain a number of points to be the same:
1. Make sure you are in Selection mode, either by picking Edit / Select from the menu or by clicking the right mouse button.
2. Click on the first point to be constrained (Or click on the circumference of a circle or arc to constrain its center).
3. Holding down the shift key, click on the second point to be constrained (Or click on the circumference of a circle or arc to constrain its center).
4. Repeat step 3 for the rest of the points to be constrained.
5. When the correct set of points is selected, pick Constrain / Same Point.

If the addition of the Same Point constraint causes the drawing to be over dimensioned, then you will see the Redundant Dimension message. Otherwise the points will be constrained to be the same.

**Fix Point / Line**

This option lets you specify a point and a line of the drawing to be fixed. The fixed point must lie on the fixed line.

This menu option is grayed out unless either a point, a line or a point and a line are currently selected.

To specify the fixed point and line:
1. Select the point (or line) to be fixed.
2. (Optionally) select the line (or point) to be fixed.
3. Choose the Constrain / Fix Point/Line option.

A pin icon will appear at the fixed point and a roller icon will appear in the middle of the fixed line.
When is it important to fix a point and line?

When velocities and accelerations are specified in Analytix, they are always relative. In order to convert these velocities and accelerations to absolutes, you need to tell Analytix what is fixed and what is moving.

Hence, for dynamic and kinematic analysis, it is necessary to specify a fixed point and line. Many static problems assume some points of the figure are anchored, for these problems it is necessary to fix a point and line.

If you use the tolerance zone analysis, you should specify a fixed point and line. These will then be assumed to be in true position and tolerance zones of other points will be displayed.

If you want to measure velocities and accelerations with respect to some moving (even accelerating) frame of reference, all you need to do is specify a point and line in that frame as being fixed.

If there are several fixed points in your drawing, you need only specify one as fixed, and fix a line joining two of the points.

**Horizontal**

This option lets you specify a line to be horizontal.

This menu option is grayed out unless a line is currently selected.

To specify a horizontal line:
1. Select the line.
2. Choose the Constrain / Horizontal option.

There can only be one line in your figure which is constrained to be either horizontal or vertical. Other horizontal or vertical lines are specified by using the parallel distance dimension or by specifying their angle to the constrained line.

**Vertical**

This option lets you specify a line to be vertical.

This menu option is grayed out unless a line is currently selected.

To specify a vertical line:
1. Select the line.
2. Choose the Constrain / Vertical option.

There can only be one line in your figure which is constrained to be either horizontal or vertical. Other horizontal or vertical lines are specified by using the parallel distance dimension or by specifying their angle to the constrained line.
View

The View menu contains options to let you Move and Rotate selected objects, Zoom in or out on the drawing and Blank selected objects. It also has options to perform level management.

For more information, see
Move
Rotate
Zoom box
Zoom min/max
Zoom out
Blank
Unblank all
Change Level...
Blank/Unblank Level...
Manage Levels...

Move

Lets you move the currently selected portion of the sketch.

To move a portion of your drawing:

1. Select the geometrical entities to be moved. (Dimensions on their own are not moved, but follow the geometry.) To select multiple entities use the shift key.

2. Choose Move from the View menu.
3. Position the cursor over the entities to be moved.
4. Press down on the left mouse button and drag the entities to their new position.
5. When the new position is reached, release the mouse button.

What is moved?

If your set of selected entities shares points with some non-selected entities, then the shared points are not moved.

For example, if you select a single edge of a polygon, then perform a move, nothing will move as both vertices of the line are shared with non-selected edges.

If you select two adjacent sides, then perform a move, the common point will move.

If you select three adjacent sides, both common points will move. This has the effect of moving the complete middle edge.

Rotate

This lets you rotate the currently selected portion of the sketch.

To perform a rotation do the following:

1. Select the geometrical objects to be rotated (Dimensions on their own are not rotated, but follow the geometry.)
2. Choose Rotate from the View menu.
3. Click on the center of the rotation (this may be any point on the screen.)
4. Position the cursor over some part of the object to be rotated (away from the center of rotation).
5. Press down the left mouse button and drag the object round.
6. When the object is correctly positioned, release the mouse button.

What is rotated?

If your set of selected entities shares points with some non-selected entities, then the shared points are not rotated.

For example, if you select a single edge of a polygon, then perform a rotate, nothing will move, as both vertices of the line are shared with non-selected edges.

If you select two adjacent sides, then perform a rotate, the common point will be rotated about the center.

If you select three adjacent sides, both shared points will move, with the effect that the common line will be seen to rotate about the center.

Zoom Box

This function lets you zoom in on your drawing.
To Zoom in on the drawing:

1. Choose the **View / Zoom** in menu option.
2. Position the cursor at the top left corner of the region which you wish to fill the entire window.
3. Press down on the left mouse button and drag the mouse to the bottom right corner of the region, creating a rectangle delineating the region.
4. Release the mouse button.

**Zoom Min / Max**

This option zooms to fit the drawing optimally to the screen.

**Zoom In**

Zooms in on the drawing.

**Zoom Out**

These options zoom out by factors of 2 or 4.

**Blank**

Blanks the currently selected entities.

A blanked entity is not visible on the screen but it is still there. For example, a dimension still constrains the drawing when it is blanked. To reverse this choose **Unblank All**.

Blanked entities are not selectable except by using the **Select All** options.

**Unblank All**

Unblanks all the currently blanked entities.

More selective control of which entities are visible and which are not may be achieved using **Blank / Unblank Level**.

**Change Level**

All entities in Analytix are drawn on a specific "level". There are 16 different levels.

Levels may be blanked and unblanked individually, thus giving you a finer degree of control over what is visible than the ordinary **Blank** and **Unblank** functions.

By default everything is placed on the first level.

If there are no currently selected entities, **View / Change Level** changes the level where subsequent entities are placed.

If you have selected entities, these will be moved to the new level.

To change levels
1. Optionally select entities whose level you wish to change.
2. Choose **Change Level** from the **View** menu.
3. The Level Management dialog appears. Click the new level.
4. Close the Level Management dialog by double clicking the System menu box in the top left corner.

**Blank / Unblank Level**

This option lets you select which levels are visible and which are not.

When you pick the **Blank / Unblank Level** menu option, you will see the Level Selection Box. The currently visible levels will be displayed normally, the currently blanked levels in negative.

Click on the miniature screen representing a level to toggle it from blanked to unblanked or vice versa.

When you are finished, double click on the System menu button in the top left corner to close the dialog box and implement the changes.

**Manage Levels**

![Levels dialog box]

This dialog can be used to switch levels, toggle level visibility, and rename levels.

To rename a level, double-click the level’s name or press F2 while a level is selected.

To change the current level or level visibility, click in their respective columns.

The current level can also now be set via a combo box on the taskbar, and selected entities can be assigned to a level through the right-click context menu.
Defaults

The **Defaults** menu lets you set up various defaults for the system. It lets you define pen colors and styles, units, default tolerance and tolerance types, and gravitational constant.

For more information, see
- Default Pens
- Pick Aperture
- System Defaults

---

© 2014 Saltire Software
Default Pens

This menu option lets you set the colors and styles (solid, dotted, dashed, etc.) of the lines used by Analytix for various parts of your drawing.

Analytix has sixteen logical pens. The Default Pens dialog box allows you to set which of these sixteen pens is used for each different type of entity. It also lets you set the color, style and width of each pen.

The list box in the top left corner of the dialog lists the different types of entities which may be drawn. Sixteen buttons next to the list box show the current color, style and width of the different pens. Sliders at the bottom of the screen let you adjust the pen color, style and width of the highlighted entity, displaying the result on the selected button.

The different entities which may be given an individual pen are:

- Geometry - all lines (except construction lines), arcs and circles.
- Constructions - Construction lines.
- Dimensions - all dimensions created by the user.
- Added Dimensions - dimensions created by Analytix when Dimension/Automatic is invoked.
• Highlight - the pen used to highlight selected entities.
• Graph - the graph line.
• Graph axes.

When you click on one of these entities the current default pen for that entity is highlighted. To change the default pen, position the cursor over one of the sixteen sample pens and click the mouse button.

To change the color and style of the current pen, use the Red Green and Blue slider bars to set red green and blue color values for the new color, use the style bar to set its style.

Note that changing the default pen for a given entity type means that, until the default is changed again, all objects of that type subsequently drawn will be drawn with the new pen. Existing objects will not be affected.

Changing the color and style of a given pen affects all objects in the drawing created with that pen.

To change the pen on existing objects, use the Attributes / Pen menu option.

**Pick Aperture**

The pick aperture is a small box around the current cursor location which Analytix uses to decide when the cursor is close enough to be considered to lie on top of a given entity.

For example, when you are in Select mode, if you click the mouse button when a particular point lies within the pick aperture, then that point will be selected. If a line crosses through the pick aperture, but neither of its end points lie in the pick aperture, then that line will be selected.

The **Defaults / Pick Aperture** menu option allows you to make the region bigger or smaller. Multiple clicks are meaningful.

**System Defaults**

This menu option lets you specify certain settings.

• Whether kinematics is to be performed.
• Whether dimensions are to be shown as numerical values or as expressions.
• Units for measuring angles.
• Units for angular velocities and accelerations.
If Kinematics is enabled, Analytix calculates velocities and accelerations as well as positions for points and lines in the drawing. Turning Kinematics off will speed up the time it takes to make changes to the drawing. (Except in the animation tools, where Kinematics is automatically turned off.)

If **Show Dimension Expressions** is enabled, then any dimensions which are given as algebraic expressions will be displayed as expressions. If **Show Dimension Expressions** is not enabled, then the value of the expression will be displayed.

As it is common practice for engineers to use different units for angles and angular velocities, Analytix lets you set these units separately.

The initial default is for angles to be measured as degrees and for angular velocities and accelerations to be measured in radians/time and radians/(time)^2

**Default Units**

You can set the units using the Defaults/Units menu option:
Your options are:
- SI (kg/m/s)
- CGS (cm/g/s)
- FPS (ft/lbs/sec)
- IPS (inch/lb/sec)
- Other

If you choose Other, you need to specify the gravitational acceleration, and whether the basic unit is a mass (ass in metric units) or a weight (force) as in English units.

Here is an example Info Box, with unit information in place:
Bar Properties

This option lets you set default values for cross sectional area and modulus of elasticity. These are used in indeterminate truss calculations.

Max / Min Tolerance

This option sets the tolerance analysis functions to return absolute tolerances, rather than statistical tolerances.

Tolerances input for dimensions are treated as absolute bounds, and the tolerances calculated for measurements from the drawing are absolute bounds on that measurement.

Tolerance zones calculated under max/min tolerancing represent the region inside which the point must lie.
Statistical Tolerance

This option sets the tolerance analysis functions to return statistical tolerances rather than absolute tolerances.

The tolerances are set to come from Normal Distributions, which can be centered at the true value of the dimension, or may be centered away from the true position for asymmetric tolerance situations.

If U and L are the upper and lower tolerances and V is the stated value of the dimension, then the Normal Distribution has standard deviation points at V-L and V+U. That is, the actual value of the dimension is taken to come from a Normal Distribution mean V + (U-L)/2 and standard deviation (U+L) / 2.

For example if the stated value of the dimension is V=10.3, and the upper tolerance is 0.03 and the lower tolerance is 0.01, then we assume a Normal Distribution mean 10.31 and standard deviation 0.02.

Tolerance outputs for dimensions are standard deviation points of a Normal Distribution. If the upper and lower resultant tolerances are the same then the distribution is centered at the true value of the measurement. If the upper and lower tolerance values are not the same then the tolerance is asymmetrical and the Normal Distribution is off-centered.

Tolerance zones are the standard deviation equiprobable curve for the bivariate Normal Distribution of the position of the point of interest.

Note

Notice that, if you enter 3-standard-deviation points rather than 1-standard-deviation point for your input tolerances, then your output tolerances will be 3-standard-deviation points.

Example

In the drawing shown, all the lengths have upper and lower tolerances of +0.01. We have measured the length of the undimensioned tab at the top right of the drawing. The upper measurement is under max/min tolerance conditions, the lower measurement under statistical tolerance conditions.

We see that under max/min conditions the tolerances stack up additively, under statistical conditions they stack up as the root sum squared.

Default Tolerance

This option lets you set default tolerances for all the linear and angular dimensions in your figure.

Tolerances may also be set individually by selecting a dimension and using the Attributes / Info menu option.

Setting the default tolerances causes all dimensions in the figure to have these tolerances. If you have already entered some special tolerances for specific dimensions, it will overwrite these. You should therefore use this option before setting specific tolerances using the dimension’s Info box.
Dynamics Defaults

The Dynamics Defaults dialog box lets you specify three things:

- Whether your units use mass (inertial mass) or weight (force).
- The gravitational constant for your system of units.
- How your drawing is aligned with the gravitational force.

Standard Units

If you are using any of the standard unit systems included in Analytix: SI, fps, or ips, then you should click on the button corresponding to that system. Analytix will automatically set whether it is a Mass system or a Weight system, and will enter the appropriate gravitational constant.

Otherwise, click on the Other button, and you will need to set the either the Mass Units or the Weight Units button and enter in the Gravitational Constant.

Gravitational or Absolute Units

In Analytix, you may specify either the mass or the weight of objects. Which one you adopt will depend on whether you are using a gravitational system of units or an absolute system.

If you are using a gravitational system (such as fps or ips) you will probably wish to use weight rather than mass (pounds rather than slugs).

If you are using an absolute system (such as SI units) you will probably want to use mass rather than weight (kilograms rather than Newtons).

In either case you need to enter the gravitational constant for the system of units you are using. (That is the force exerted by gravity on a unit mass).

If you are using a gravitational system, then Analytix uses the gravitational constant to calculate the dynamic force acting on a given accelerating weight.

If you are using an absolute system, Analytix uses the gravitational constant to calculate the body
force on the model due to gravity.

**Drawing Alignment**

In calculating resultant forces, Analytix considers three types of forces applied to the model.

- External applied forces and torques (Created using the Analysis / Add Load menu option)
- Dynamic forces due to accelerating masses and moments of inertia.
- Body forces due to the effect of gravity on masses.

If your drawing is aligned horizontally then only the first two types of forces are considered.

If your drawing is aligned vertically, then each point has a gravitational force applied. The force is equivalent to the mass times the gravitational constant and is applied in the downward (negative) y direction.

If your drawing is inclined at some other angle theta, a force is applied which is equivalent to the mass times the gravitational constant times sin(theta). The force is applied in the negative y direction. This models the situation where the part is on a plane inclined at theta degrees to the horizontal.

**Tools**

This menu contains a number of tools to let you view the behavior of your model. There are drawing animation tools, calculation tools, drawing information tools and a switch to display the toolbox icon bar.

The animation tools: **Animate**, **Increment**, **Trace** and **Envelope** are grayed out if the drawing is not consistently dimensioned.

For more information, see
Animate
Increment
Trace
Envelope
Calculator
Univariate Iteration
Multivariate Iteration
Iteration Manager
Graph
Table
Align Annotations
Toolbox

Animate

The **Animate** tool lets you watch your drawing move as Analytix steps the value of a variable through a prescribed range.

The variable will often be the value of some dimension.

When you pick **Tools / Animate**, you will see the Iteration Parameter Box. This lets you enter a variable for the parameter to be iterated on and initial and final values for the parameter. It also has a place to enter the step size to use.

Frequently the iteration parameter will be one of the dimensions of the drawing. In this case, you can position the text cursor in the Iterator Box then go back into the main drawing and select the dimension.

The dimension's name will be automatically entered into the Iterator Box.

When you have filled in the iteration parameters, click on **Ok** to start the animation.

The iteration parameter is remembered by Analytix. Next time you use **Animate**, **Trace** or **Envelope** you will notice that the parameter's details are already in the Iteration Parameter Box. To perform the same animation again, you just need to click on **Ok**.

Increment

This tool lets you step through an animation by incrementing (or decrementing) a particular variable. The variable would typically be a dimension or a variable on which one or more dimensions depend.

The Increment box has an edit control to enter the variable to be incremented (Iterator), and one to enter the quantity to be added or subtracted (Step Size).

To increment a dimension, make sure the text cursor is in the Iterator box, then return to the main Analytix window and select the dimension which you wish to alter.
Clicking on the + box adds the quantity in the Step Size box to the variable (or dimension) in the Iterator box, then causes the drawing to be recalculated.

Clicking on the - box subtracts the quantity in the Step Size box from the variable (or dimension) in the Iterator box, then causes the drawing to be recalculated.

Close the Increment box by double clicking in the system menu box in its top left corner.

**Trace**

This tool draws the path followed by a point during the course of an animation.

To use the Trace tool, you must have:

- A consistently dimensioned drawing.
- A single point selected.

Unless you have both of the above, the Trace menu option is grayed.

When you select the trace tool, the Iteration Parameter Box appears. Fill in the variable or dimension on which the motion depends, its start and end values and step size.

If you have already used one of the animation tools, the information from your last use should already be in the Iteration Parameter Box.

The Trace Tool draws on a special layer of the drawing called the background layer. Traces cannot be individually selected and deleted. Instead you delete the whole background layer using the Edit / Erase Background menu option. The background layer is also used by the Tolerance Zone analysis tool.

**Envelope**

The Envelope tool performs an animation where the screen is not refreshed between frames. The effect of this is to give a representation of the total space occupied by the part over the prescribed range of motion.

When you select the envelope tool, the Iteration Parameter Box appears. Fill in the parameter or dimension on which the motion depends, its start and end values and step size.

If you have already used one of the animation tools, the information from your last use should already be in the Iteration Parameter Box.

The envelope is only drawn temporarily. It is removed whenever you cause the screen to be refreshed.

**Calculator**

The Calculator tool lets you evaluate expressions and define variables.
Expressions can be numeric:
5*(8-4.6)
\sqrt{17^2-5^2}
or may contain variables:
a/(b^2-c^2)
distance(point27,point13).
You can assign values to variables:
a = 27
b = \cos(45)
DIMENSION17 = 10
or you can assign expressions to variables:
a = (b-c)/(d+e)
DIMENSION21 = \sqrt{a^2+b^2}

Variables (except for dimension names) can be up to 10 characters long and must start with a letter:
e.g. rad, x12, bladevel

There is a special set of variables which are predefined by the drawing. These are the dimensions. The dimension name consists of DIMENSION followed by the number of that dimension.
e.g. DIMENSION17, DIMENSION237

If you assign a dimension variable, this has the effect of inserting the value or expression on the right hand side of the assignment into that dimension in the drawing.

If the expression which you assign to a variable itself contains variables which have not been declared yet, the Calculator will declare the value of the expression to be undefined. When the necessary variables are defined, the calculator will fill in the values.

You cannot enter circular definitions: e.g.
a = b+c
c = 2*b-a

This is not allowed as c is in the expression which defines a and a is in the expression which defines c.
You can, however enter:
a = b+c
b = 27
c = \sqrt{b}
even though b and c are not defined at the time when a is declared.

If you have a lot of variables, you can conveniently arrange them alphabetically by checking the
Sorted checkbox at the bottom left corner of the dialog.

Another useful feature if you have a long variable list is to expand the Calculator dialog by clicking and dragging the corners.

See the following sections for the complete list of built-in expressions and functions:
Calculator Expressions
Functions

Expressions

The arithmetic operations used in the calculator are:

- sum: \( a + b \)
- difference: \( a - b \)
- product: \( a \times b \)
- division: \( a \div b \)
- power: \( a^b \) or \( a^{\ast b} \)
- parentheses: \( a-(b+c) \)

The following logical expressions are available:

- greater than: \( a > b \)
- less than: \( a < b \)
- greater than or equal: \( a \geq b \)
- less than or equal: \( a \leq b \)
- equal: \( a = b \)
- not equal: \( a \neq b \)
- not: \( \neg a \)
- and: \( a \land b \)
- or: \( a \lor b \)

For example, the following expression returns 1 if \( a \) lies between 1 and 2 and 0 otherwise:

\[
\text{if } ((a\geq1) \text{ and } (a<2),1,0)
\]

The if statement is detailed in the Functions section below.

Functions

Here we will list the different functions which are available in Analytix. These functions may be used as part of expressions, either in the calculator or in specifying what expression to graph or table. Functions take one or more of the following as arguments:

- real numbers
- points
- lines
- dimensions
• actuators

Points, lines, dimensions, and actuators in the drawing are named by the system (DIMENSION12) and can be entered when the keyboard focus is in the calculator text box by simply clicking the element in the drawing.

Functions are organized in the sections below. The alphabetical listing gives complete details.

Functions By Category
Functions - Alphabetical

Mathematical
• \( \text{arccos}(\text{real}) \) - same as \( \cos() \)
• \( \text{arcsin}(\text{real}) \) - same as \( \sin() \)
• \( \text{arctan}(\text{real}) \) - same as \( \tan() \)
• \( \cos(\text{real}) \)
• \( \exp(\text{real}) \)
• \( \ln(\text{real}) \)
• \( \log(\text{real}) \)
• \( \log10(\text{real}) \)
• \( \text{signum}(\text{real}) \) - same as \( \text{sgn()} \) or \( \text{sign()} \)
• \( \sin(\text{real}) \)
• \( \sqrt{\text{real}} \) - same as \( \text{root()} \)
• \( \text{step}(\text{real}) \)
• \( \tan(\text{real}) \)
• \( \abs(\text{real}) \)
• \( \text{solve()} \)
• \( \text{solve}(\text{iteration1}) \)
• \( \text{evalsolved}(\text{expression1}) \)
• \( \text{evalsolved}(\text{iteration1}, \text{expression1}) \)

Geometrical
• \( \text{angle}(\text{line1}, \text{line2}) \)
• \( \text{distance}(\text{point1}, \text{point2}) \)
• \( \text{distance}(\text{point1}, \text{line1}) \)
• \( \text{length}(\text{line1}) \)
• \( \text{xcoord}(\text{point1}) \)
• \( \text{ycoord}(\text{point1}) \)
Logical
- \texttt{if(condition, statement, statement)}

Area and Mass properties - See the Info Group section for details of these functions.
- \texttt{area(group)}
- \texttt{Imax(group)}
- \texttt{Imin(group)}
- \texttt{Ix(group)}
- \texttt{Ixy(group)}
- \texttt{Iy(group)}
- \texttt{Iz(group)}
- \texttt{xcentroid(group)}
- \texttt{ycentroid(group)}
- \texttt{totalmass()}

Velocities & Accelerations
- \texttt{aangle(line1, line2)}
- \texttt{acc(point1)}
- \texttt{adistance(point1, point2)}
- \texttt{adistance(point1, line1)}
- \texttt{alength(line1)}
- \texttt{angacc(line1)}
- \texttt{angvel(line1)}
- \texttt{vangle(line1, line2)}
- \texttt{vdistance(point1, point2)}
- \texttt{vdistance(point1, line1)}
- \texttt{vel(point1)}
- \texttt{vlength(line1)}
- \texttt{xacc(point1)}
- \texttt{xvel(point1)}
- \texttt{yacc(point1)}
- \texttt{yvel(point1)}

Forces, Torques, Bending Moments & Deflections
- \texttt{react(dimension1)}
- \texttt{react(point1, line1)}
- \texttt{react(point1, group1)}
- \texttt{xreact(point1, line1)}
• \textit{xreact(point1, group1)}
• \textit{yreact(point1, line1)}
• \textit{yreact(point1, group1)}
• \textit{react(actuator1)}
• \textit{moment(point1, line1)}
• \textit{shear(point1, line1)}
• \textit{stress(line1)}
• \textit{def(point1)}
• \textit{xdef(point1)}
• \textit{ydef(point1)}

\textbf{Functions - Alphabetical}

\texttt{aangle(line1, line2)}  
Returns the acceleration of the angle between line1 and line2.

\texttt{abs(real)}  
Returns the absolute value of real.

\texttt{acc(point1)}  
Returns the acceleration of point1.

\texttt{adistance(point1, point2)}  
Returns the acceleration of the distance between point1 and point2.

\texttt{adistance(point1, line1)}  
Returns the acceleration of the distance between line1 and line2.

\texttt{alength(line1)}  
Returns the acceleration of the length of line1.

\texttt{angacc(line1)}  
Returns the angular acceleration of line1.

\texttt{angle(line1, line2)}  
This function returns the angle between line1 and line2. The angle is given in current angular units (by default degrees).

\texttt{angvel(line1)}  
Returns the angular velocity of line1.

\texttt{arccos(real)} Same as \texttt{acos(real)}  
Returns the inverse cosine of real in the range between 0 and 180. The value of real must lie between -1 and 1.

\texttt{arcsin(real)} Same as \texttt{asin(real)}
Returns the inverse sine of real in the range between -90 and 90. The value of real must lie between -1 and 1.

**arctan(real)** Same as **atan(real)**
Returns the inverse tan of real in the range between -90 and 90.

**area(group)**
Returns the area enclosed by the profile defined in group

**cos(real)**
Returns the cosine of angle real. Real is measured in current angular units (by default degrees).

**def(point1)**
Returns the deflection of point1 on a truss.

**distance(point1, point2)**
Returns the distance between point1 and point2.

**distance(point1, line1)**
Returns the perpendicular distance between point1 and line1.

**evalsolved(expression)**
Evaluates expression with the solution to the active multivariate iteration. See the Iteration Manager section below.

**evalsolved(iteration1,expression)**
Evaluates expression with the solution to the multivariate iteration saved in the Iteration Manager as iteration1.

**exp(real)**
Returns e\(^r\)(real)

**if(logical expression, real1, real2)**
Returns real1 if logical expression is true, returns real2 otherwise.

**Imax(group)**
Returns the maximum area moment of inertia through the centroid of the object defined by group.

**Imin(group)**
Returns the minimum area moment of inertia through the centroid of the object defined by group.

**Ix(group)**
Returns the area moment of inertia about the x-axis through the centroid of the object defined by group.

**Ixy(group)**
Returns the area product of inertia of the object defined by group.

**Iy(group)**
Returns the area moment of inertia about the y-axis through the centroid of the object defined by
group.

\textbf{Iz(group)}

Returns the area moment of inertia about the z axis through the centroid of the object defined by group.

\textbf{length(line1)}

Returns the length of line1.

\textbf{ln(real)}

Returns the natural logarithm of real. Real must be positive.

\textbf{log(real)}

Returns the natural logarithm of real. Real must be positive.

\textbf{log10(real)}

Returns the base 10 logarithm of real. Real must be positive.

\textbf{moment(point1, line1)}

Returns the bending moment of line1 at point1.

\textbf{react(actuator1)}

Returns the force in actuator1.

\textbf{react(dimension1)}

Returns the reaction force (or torque) in dimension1.

\textbf{react(point1)}

Returns the reaction force on point1.

\textbf{react(point1, line1)}

\textbf{react(point1, group1)}

Returns the force on point1 as a member of line1 or group1.

\textbf{shear(point1, line1)}

Returns the shear force at point1 on line1.

\textbf{signum(real)}

Same as \textbf{sign(real)} or \textbf{sng(real)}

Returns -1 if real < 0; returns 0 if real =0; returns 1 if real > 0.

\textbf{sin(real)}

Returns the sine of angle real. Real is measured in current angular units (by default degrees).

\textbf{solve()}\textbf{solve(iteration1)}

Solves the active multivariate iteration, if on is defined. See the Iteration Manager section below.

\textbf{solve(iteration1)}

Solves the multivariate iteration saved in the Iteration Manager.
\texttt{sqrt(real)} same as \texttt{root(real)}

Returns the square root of \texttt{real}. \texttt{Real} must be positive.

\texttt{step(real)}

Returns 0 if \texttt{real} < 0; returns 1 if \texttt{real} \geq 0.

\texttt{stress(line1)}

Returns the stress in \texttt{line1} (used in truss analysis).

\texttt{tan(real)}

Returns the tangent of angle \texttt{real}. \texttt{Real} is measured in current angular units (by default degrees).

\texttt{totalmass()}\n
Returns the sum of all point masses in the model.

\texttt{vangle(line1, line2)}

Returns the velocity of the angle between \texttt{line1} and \texttt{line2}.

\texttt{vdistance(point1, point2)}

Returns the velocity of the distance between \texttt{point1} and \texttt{point2}.

\texttt{vdistance(point1, line1)}

Returns the velocity of the distance between \texttt{point1} and \texttt{line1}.

\texttt{vel(point1)}

Returns the velocity of \texttt{point1}.

\texttt{vlength(line1)}

Returns the velocity of the length of \texttt{line1}.

\texttt{xacc(point1)}

Returns the x component of the acceleration of \texttt{point1}.

\texttt{xcentroid(group)}

Returns the x coordinate of the centroid of the area defined by \texttt{group}.

\texttt{xcoord(point1)}

Returns the x coordinate of \texttt{point1}.

\texttt{xdef(point1)}

Returns the x component of the deflection of \texttt{point1} (used in truss analysis).

\texttt{xreact(point1)}

Returns the x component of the reaction force on \texttt{point1}.

\texttt{xreact(point1, line1)}\texttt{xreact(point1, group1)}

Returns the x component of force on \texttt{point1} as a member of \texttt{line1} or \texttt{group1}. 
xvel(point1)
Returns the x component of the velocity of point1.

yacc(point1)
Returns the y component of the acceleration of point1.

ycentroid(group)
Returns the y coordinate of the centroid of the area defined by group.

ycoord(point1)
Returns the y coordinate of point1.

ydef(point1)
Returns the y component of the deflection of point1 (used in truss analysis).

yreact(point1)
Returns the y component of the reaction force on point1.

yreact(point1, line1)
yreact(point1, group1)
Returns the y component of force on point1 as a member of line1 or group1.

yvel(point1)
Returns the y component of the velocity of point1.

Mass / Weight Calculator

<table>
<thead>
<tr>
<th>Point</th>
<th>Expression</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>POINT1</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>POINT2</td>
<td>7.12</td>
<td>7.12</td>
</tr>
<tr>
<td>POINT8</td>
<td>35.36</td>
<td>35.36</td>
</tr>
<tr>
<td>POINT12</td>
<td>657.24</td>
<td>657.24</td>
</tr>
<tr>
<td>POINT20</td>
<td>5.92</td>
<td>5.92</td>
</tr>
<tr>
<td>POINT65</td>
<td>5.92</td>
<td>5.92</td>
</tr>
<tr>
<td>POINT76</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>POINT80</td>
<td>4.04</td>
<td>4.04</td>
</tr>
</tbody>
</table>

Total weight: 23130.4 lbs

You can examine all of the points with masses or weights attached in one dialog by selecting **Mass / Weight Calculator** from the **Tools** menu.
- **Point** - displays the point name assigned internally by Ax.
- **Expression** - displays an expression if one is defined, otherwise the **Expression** and **Value** columns are the same.
- **Value** - displays the value, in either weight or mass units, depending on the **Default Units** set.
See Attributes / Info to define a point's value or expression. Double click a point in the Mass / Weight Calculator data window to edit the point's value or expression.

This dialog can be resized by clicking and dragging the corners.

**Univariate Iteration**

This tool implements a univariate root finder.

This uses an iterative technique to solve equations which cannot be written as a simple expression.

Enter the variable for which you wish to solve in the Variable box, and the equation you want solved in the Solve Box. Press Ok to calculate. The solution and error will appear below if the numerical analysis algorithms converge to a solution. Otherwise you will be given an error message.

![Iteration Dialog](image)

While the Iteration tool is useful for solving equations, its real power comes when it is coupled with the drawing. This coupling is achieved when both the following are true:

- The variable is an input to the drawing (either a dimension name or a variable on which one or more dimensions depend).
- The equation to be solved includes some functions which depend on the drawing (such as angles or distances).

When drawing entity names (lines, points, circles, dimensions) are required in the Iteration Box they may be entered by positioning the text cursor in the data entry field then selecting the entity in the main drawing.

The last iteration entered is saved in the dialog.

**Multivariate Iteration**

This tool implements a multivariate root finder.

It allows you to simultaneously solve a system of equations in a number of unknowns. (The number of equations must be equal to the number of unknowns.)
To specify a multivariate iteration problem, you need to specify the names of the variables whose values you wish to find. You also need to specify the equations which you wish to solve.

Variables may be any calculator variables, or the names of any dimensions. Equations may be any valid calculator expressions.

To enter a variable, type into the text entry field at the top of the multivariate iteration dialog, then click the Add V. button.

To enter an equation, type into the text entry field at the top of the multivariate iteration dialog, then click the Add E. button.

The example above shows the dialog box for solving the system

\[ \begin{align*}
x + y &= 15 \\
x^2y &= 25
\end{align*} \]

for \( x \) and \( y \).

The value for \( x \) and \( y \) which the solver found may be inspected by clicking on the down arrow at the right of the Result box.
Conditions

It is also possible to specify conditions which are to be set for each of the equations. These conditions take the form of assignment statements, such as \( x=23 \), \( \text{DIMENSION13}=90 \), \( \text{DIMENSION27}=2^*t \), etc.

A set of such conditions may be attached to each equation. Before it tests the value of the equation, the multivariate root finder will first perform all the condition assignments attached to that equation.

The condition assignments are particularly useful for mechanism synthesis problems.

To enter a condition, select the equation to which the condition will be attached, type it into the Conditions text entry field and click the Add C. button.

Delete & Modify

To select a variable or equation, click its representation in the Variables list or the Equations list.

To select a condition, first select the equation to which the condition is attached, then click the condition in the Conditions list.

To delete a variable, equation or condition, first select it, then press the Delete button.

To modify a variable, equation or condition, first select it, then modify the text in the text entry field, then press the Modify button.

Setting Computation Parameters

You can set three parameters which let the iterative equation solver decide when to accept a solution, and when to give up trying to find a solution.

The Max Iterations field lets you specify how many iterations of a Newton Raphson root finding
The algorithm will be performed before the solver gives up and returns a *Numerical Error*.

The **Accuracy** and **Tolerance** fields specify how close you need your solution to lie to the real solution. The solver accepts a solution as successfully converged if each variable is within the **Accuracy** value of a true solution and the error in each equation is less than the **Tolerance** value.

**What if the iteration is unsuccessful?**

If your iteration fails to converge, it may indicate that there is no solution to the problem you are posing, or it may mean that a solution exists but the iterative equation solver was unable to find it.

The equation solver uses the current values of the input variables as a “first guess” at the solution. Changing the initial values of the variables might help the equation solver converge.

As a general rule, the closer the initial guess is to the solution, the more chance there is that the solver will converge.

**Iteration used to Generate Graphs & Tables**

You can use **Multivariate Iteration** to calculate a dependent variable in a **Graph** or **Table** since an active iteration will be run before each point is calculated. For instance, if DimensionB was found using a Multivariate Iteration, and it depended on DimensionA, you can plot Dimension B as a function of Dimension A.

Note: If you don’t want the Multivariate Iteration to run when you are graphing, be sure to clear the Multivariate Iteration dialog box.

**Iteration Manager**

Multivariate iteration problems can be named, saved, and restored using the **Iteration Manager** dialog, available in the **Tools** menu.

To use this, iteration problems should be entered into the **Multivariate Iteration** dialog.
Store Current - prompts for a name to save the problem (if it hasn't already been saved).

Edit - restores to the selected problem in the list for modifying and re-solving in the Multivariate Iteration dialog. You can also open a saved problem by double-clicking the problem in the list. After editing a problem, make sure to save your change by returning to the manager dialog and clicking the Store Current button.

Toggle Active – marks the selected problem as Active, to be continuously solved when generating a table or graph

Delete - deletes the selected iteration.

Cancel - undoes any changes you have made to the iteration list and restores it to its former state.

OK - closes the dialog saving all changes.

Multivariate Iteration over DDE

Multivariate iteration problems can now be solved over DDE. The following Excel macro shows how this works:

```excel
channelNumber = Application.DDEInitiate(app:="ax", topic:="c:\yourfilename.ax")
Application.DDEExecute channelNumber, "solve()"
Application.DDETerminate channelNumber
```

A non-active iteration problem can be solved by passing “solve('problem name')” to Excel's DDEExecute function, where the 'problem name' is the name of the saved iteration. Calculator statements can be executed in this way as well.

Look in the Edit menu section for details on importing / exporting DDE links.

Graph

This tool lets you create a graph.

When you select the Graph tool you are presented with a dialog box which requires you to enter a variable for the x axis, an expression for the y axis, and an initial value, final value and step size for the x axis variable.

Click on Ok to see the graph.

The graph facility is most useful, however, when the x-axis variable is an input to the drawing and the y-axis variable is an output.

For example, if the x-axis variable is the value of a particular dimension, and the y-axis variable is the angle between a pair of lines.

When drawing entity names (lines, points, circles, dimensions) are required in the Graph Parameters Box they may be acquired by positioning the text cursor in the appropriate entry field.
then selecting the entity in the main drawing.

To remove the graph from the screen, double click the System Menu Box in the upper left corner of the graph window.

**Table**

You can display the values as a table by clicking on the **Table** option of the graph window's System Menu.

**Table**

This tool creates a table of the values of an expression for a given range of an expression.

The Table dialog box is identical to the Graph Parameter Box.

It allows you to enter an independent variable and a dependent expression. It also lets you set Initial and Final values for the independent variable and a step size.

Click on **Ok** to generate a table.

The table originally appears small and in the top left of the screen. It can be repositioned by dragging its title bar and resized by dragging the frame around the Table window.

The Scroll bar in the Table allows you to scroll through the values.

**Copy**

The Copy option in the Table menu copies the table values onto the Windows Clipboard. It is copied in a text format with values separated by tabs. This format allows the table to be pasted into an Excel spreadsheet. Alternatively it may be pasted into a word processor document.

**Graph**

Clicking on **Graph** in the Table menu allows you to turn your table into a graph.

**Align Annotations**

Select the annotations on the screen that you want to line up. Then click **Align Annotations** from the **Tools** menu to bring up the **Align Annotations** dialog box.
This automatically spaces and aligns the selected annotations, aligning to left, center, right, or the position of the first variable reference in the annotation string. Variables defined in the Calculator are inserted into annotations between @ signs.

**Toolbox**

For those of you who miss our old, grey toolbox, it's still here where you left it, on the left! Just click the Toolbox checkbox in the Tools menu.

**Attributes**

The Attributes menu contains two very important functions for communicating with the drawing.

1. The Info function gives you information on the currently selected entity, and lets you add more information to it, such as the velocity and tolerance of a dimension, the mass of a point, the moment of inertia of a line.

2. The Measure function lets you measure distances and angles (along with their tolerances) from the drawing.

There is also the Pen function which lets you change the style and color of the selected graphic entities, and the Font function lets you change the style and size of any alpha-numeric in the drawing.

For more information, see

- Info
- Measure
- Pen
This function brings up the **Info** dialog for the particular entity which is selected.

The **Attributes / Info** menu option is grayed out unless you have a single entity selected.

The **Info** dialog tells you the various parameters and properties of the selected entity, and lets you edit whichever ones are appropriate.

**Keyboard Shortcut:**
Press [Control] + I

**Mouse Shortcut**
Double clicking on an entity while in select mode will select the entity and bring up the **Attributes / Info** dialog.

**Info Dimension**

The **Dimension Info** dialog lets you edit the dimension’s value, its velocity and acceleration and its tolerances.

To open the dialog, double click the dimension on the drawing, or select the dimension and **Attributes / Info**.

**Ok** saves your changes and closes the dialog.

**Cancel** discards your changes, reverting to the previous values, and closes the dialog.
Bounds lets you set upper and lower limits on the dimension Value.

Info Point

If you select a point then pick Attributes / Info, you will see the Points Info dialog. You can also double click the point to invoke the dialog.

This tells you the position, velocity and acceleration of the point. It also lets you input / edit the mass or weight of the point. This input value can be numeric, a variable, or an expression. Variables are defined in the Calculator.

If you leave the Info Point dialog on the screen while you change the value of a dimension affecting that point, you will see values in the Info Point dialog automatically updated.

You can make the Info Point box less wasteful of screen space by moving and resizing it.

Ok saves your changes and closes the dialog.

Cancel discards your changes, reverting to the previous values, and closes the dialog.

Bounds lets you set upper and lower limits on the dimension Value.

Info Line

The Info Line dialog tells you the length of a line, its angular velocity and acceleration, and tolerances on its length.

You can edit the moment of inertia of the line.

If the line represents the bar of a truss, you can define its cross sectional area (A) and its modulus of elasticity (E). (See also Defaults / Bar Properties, and Analysis / Stress)
Ok saves your changes and closes the dialog.

Cancel discards your changes, reverting to the previous values, and closes the dialog.

**Info Group**

Double clicking on a group while in select mode (or clicking on the group then selecting Attributes / Info) brings up a box which displays the area mass properties of the group.

These properties are:

- **Area** - the area of the outer profile minus any profiles contained within. (If the profiles intersect the result is meaningless.)
- **Ix** - Area moment about the x-axis through the centroid.
- **Iy** - Area moment about the y-axis through the centroid.
- **Iz** - Area moment about the z-axis through the centroid. (This is sometimes denoted J).
- **Ixy** - Area product of inertia through the centroid.
- **Imax, Imin** - Maximum and minimum area moments through the centroid.
- **thetamax, thetamin** - the angles which the directions of maximum and minimum area moments make with the x-axis.
- **Xc, Yc** - the x and y coordinates of the centroid.

**OK** - closes the dialog.
You create a group using the Edit / Group Selected Lines/Arcs menu option.

Measure

This function lets you measure quantities from the drawing.

You can measure:

- The distance between two points.
- The perpendicular distance between a point and a line.
- The angle between two lines.

Tolerances are given for these measurements.

The Measure box tells you whether the tolerances were measured under an assumption of absolute or statistical tolerance accumulation.

If you leave the Measure box on screen, you can change dimension values and watch the measurement update.

To close the dialog, click red X in the top right corner.

Tolerance Sensitivity Analysis

Analytix adds tolerance sensitivity analysis to its measurement functions. Sensitivity analysis is performed after using the Attributes / Measure menu option to display the effective tolerance on a distance or angle in the drawing.

Sensitivity analysis is invoked by pressing the Sensitivity button on the Measure dialog. The Tolerance Sensitivity display lists the dimensions in the figure along with the percentage contribution of each dimension to the tolerance stack up.
If you click a particular dimension name in the Tolerance Sensitivity box, that dimension will be highlighted in the drawing.

If you double click on the dimension name, the Info box for that dimension is displayed. This enables you to adjust the tolerance on the selected dimension and watch the effect of the adjustment on its contribution to the stack-up.

Pen

This option lets you change the pen used for the selected entities.

To use this function:
1. Select the entities whose pen you wish to change.
2. Choose Attributes / Pen.
3. Click on the new pen you wish to use.

You can also change the color, style and width of the selected pen using the sliders.

Note that changing the color, style and width of a pen will affect all the other entities which have been drawn using that pen.

Ok saves your changes and closes the dialog.

Cancel discards your changes, reverting to the previous values, and closes the dialog.

Font

This option lets you change the default Font, Font style, point Size and Script.

The default font applies to all dimension symbols and new annotations.

The Show more fonts button links to your Control Panel / Appearance and Personalization where Windows keeps additional fonts.
Ok saves your changes and closes the dialog.

Cancel discards your changes, reverting to the previous values, and closes the dialog.

Analysis

The Analysis menu contains options to allow you to add external forces and torques and actuators to the drawing, to measure the resultant force in a dimension or on a point, to analyze stress and deflection of trusses and shear force and bending moments at some point on a line, and to report instantaneous accelerations of any point or line in a model which contains masses or applied forces. You can collect a sequence of drawing configurations as a playback simulation which can be used in many of the Tools functions. The Analysis menu also has Tolerance Analysis functions which create a tolerance zone or a tolerance trace of a given point.

Note: your model must be Consistently Dimensioned in order to perform analysis calculations.

For more information, see

Add Load
Add Actuator
Add Stops
Edit Stops
Resultant Force/Torque
Stress
Shear/Bending Moment
Force on Pin
Derive Accelerations
Dynamic Simulation
New Simulation
Edit Simulation
Tolerance Zone
Tolerance Trace
Add Load

This is the option which allows you to add an externally applied force or torque to the drawing.

The menu option is grayed out unless a point or line is selected.

**Applied Force**

To add an applied force to the model:

1. Select the point where the force is to be applied.
2. Pick the Analysis / Add Load menu option.
3. Fill in the x and y components of the force in the Load dialog box.

The applied force appears in the diagram as a small arrow pointing towards the point of application, with the force size typed at its tail.

**Applied Torque**

To add an externally applied torque to the model:

1. Select the line to which the torque is to be applied.
2. Pick Analysis / Add Load from the menu.
3. Fill in the value of the torque and its direction (Clockwise or Counter-Clockwise).

The applied torque symbol is a curved arrow applied to the center of the line. Torques may be applied to construction lines.

**Applied Loads and Fixed Points and Lines**

Applied forces and torques are used in performing Static and Dynamic analysis. Analytix will perform either a static equilibrium analysis of the figure or a dynamic equilibrium analysis (if there are masses defined and there is movement).

There is no constraint on the user to enter a balanced set of external forces and torques. Hence Analytix must be able to add balancing external forces and torques so that the entire drawing has zero total force.

**Where does Analytix apply these extra forces?**

A balancing force is applied to the fixed point and a balancing torque is applied to the fixed line.

This means that unless the external forces and torques which you add have a zero sum, you...
should make sure you set the fixed point and line appropriately for your statics or dynamics problem.

If you do not, then Analytix will apply balancing forces and torques to an arbitrary fixed point and line. This will make your results somewhat difficult to interpret.

**Add Actuator**

An actuator may be composed of any combination of Spring, Damper, Actuator. It may be translational or rotational.

To create a translational actuator, select its two endpoints (holding down the Shift key while selecting the second) then choose *Analysis / Add Actuator* from the menu.

To create a rotational actuator, select the two lines to which it is to be attached (holding down the Shift key while selecting the second) then choose *Analysis / Add Actuator* from the menu.

When you select *Analysis / Add Actuator*, you will see the Actuator Dialog Box. This lets you select any combination of spring, damper and black-box actuator.

**Spring**

If you select *Spring*, you should enter both the unextended length (free length) of the spring and the spring stiffness (spring rate). This stiffness should be in force/distance units. In SI units, this would be N/m, in fps lb/ft, in ips lb/in.

**Damper**

If you select *Damper*, you need to enter the damper constant (damping coefficient). This is in units of force per unit velocity. In SI it is in Ns/m, in fps it is lb.s/ft, in ips it is lb.s/in.

**Black Box**

A black box actuator lets you enter your own formula for a force which acts between the endpoints of the actuator. (Or, in the case of a rotational actuator a torque acting between two lines.) A positive force in the black box actuator denotes a force tending to pull the ends of the actuator together (a tensile force). A negative force in the black box actuator denotes a force tending to push the ends of the actuator apart.

**Tension & Compression**

If the actuator is set to be *Tension Only*, the spring will exert force only if its length is greater than its unextended length. If the actuator is set to be *Compression Only*, it will exert force only if its length is less than its unextended length. If the actuator is set to be *Tension and Compression*, then it will exert a force whether its length is greater or less than its unextended length.

**Uses**
An actuator may be any one of the types Spring, Damper, Black Box, or it may be any combination:

- Spring & Damper
- Spring & Black Box
- Damper & Black Box
- Spring & Damper & Black Box

The Spring & Damper combination provides a useful model of a shock absorber.

A Damper alone can provide a crude linear model of friction. (A rotational damper may be used to model friction at joints). Alternatively you can use a black box actuator to enter a more sophisticated friction model.

### Add Stops

Stops are used to model collisions - situations where two components of a model collide and rebound.

A simple example of such a collision would be a ball bouncing on the ground.

A stop specifies the condition that a particular point will "stop against" a particular line. If the dynamic simulation determines that the point is about to pass through the line, it will not let this happen. Instead it will model the interaction between the point and the line as an instantaneous elastic/plastic collision. The point will bounce back away from the line with a speed determined by the coefficient of restitution given when specifying the stop.

A coefficient of restitution of 1 means that the collision will be modeled as perfectly elastic, and no energy is lost in the collision. A coefficient of restitution of 0 would be a perfectly plastic collision. A coefficient of restitution between 0 and 1 would imply some loss of energy during the impact.

Note: due to the particular techniques used to integrate the dynamical equations, you shouldn't use stops to model totally plastic collisions, instead you should use bounds on a dimension.

To create a Stop you need to select the point and the line which will collide with each other.

First select the point then, holding down the Shift key select the line.

Now select **Analysis / Add Stop**.

You will see the **Stop** dialog box, which requires you to enter a coefficient of restitution. This should be a number greater than 0 and less than or equal to 1.

An alternative method of simulating collisions is to use a compression-only spring/damper combination. As the spring for such a collision would typically be very stiff, this introduces a technical condition called **stiffness** into the dynamics equations. Stiffness slows down the dynamics algorithms considerably and should be avoided if possible. Hence it is generally better to use stops rather than stiff springs.

Values for the closing velocity and for the impulse at the collision may be examined by specifying that impulses be sent to the calculator when you start the **dynamic simulation**.

The impulse is a measure of force times time over the duration of the collision (assumed to be
short.) The closing velocity is the component of the velocity of the point

Edit Stops

The Analysis / Edit Stops menu option lets you change the coefficient of restitution of Stops which you have already created.

Alternatively, you can delete existing stops.

Resultant Force / Torque

The Analysis / Resultant Force/Torque and Analysis / Force on Pin options are the ways in which you ask Analytix for the results of static or dynamic analysis.

The Analysis / Resultant Force/Torque option is grayed out unless a dimension is currently selected.

To use Analysis / Resultant Force/Torque:

1. Select a dimension.
2. Pick Analysis / Resultant Force/Torque from the menu.

The Resultant Force/Torque dialog box will appear, which tells you (for a linear dimension) the force in the dimension or (for an angle) the torque in the dimension.

The force is either a Tension or Compression.

The model where internal forces are transmitted in dimensions may appear a little strange at first, but it is very easy to get used to and means you do not need to learn a whole new set of tools to specify how a frame or mechanism is connected up. You do this by the way you specify dimensions.

For example, if two bars come together at a welded joint which is capable of transmitting moment, then it is appropriate to enter the angle dimension between the lines. The moment transmitted by the joint is just the resultant torque in the angle dimension.

Stress

Analytix allows you to do Stress analysis and Deflection analysis on trusses. The trusses may be simple, compound or redundant. Each member of the truss, however must be a two force member. That is, the lines forming the truss must only be joined at their ends. This means that forces are all along the axis of truss members and there is no bending.

In order to do stress analysis you need first to define a cross sectional area and a modulus of elasticity for each bar in the truss. You can do this for each line individually using Attributes / Info, or you can set them all at once using Defaults / Default Bar Properties.

In contrast to the standard Analytix static model, the truss may be dimensioned in any way. In truss analysis it is the lines rather than the dimensions which are responsible for bearing the loads.

Loads may be applied to the ends of any of the lines representing truss members. Loads may not be applied to points in the middle of lines representing truss members as such loads would
conflict with the requirement that the members carry only axial load.

To perform stress analysis, select the line representing the appropriate truss member, then choose Analysis / Stress.

You will see the Stress dialog box.

If you have not specified cross sectional areas and modulus of elasticity for sufficient lines to define a rigid structure, then an error message will appear.

Stress may also be derived using the function:

stress(line1)

Shear / Bending Moment

The normal Analytix static model (as opposed to the truss analysis model used for stress and deflection analysis) allows the existence of transverse forces applied to members. Analytix lets you display the shear force and bending moment at a particular point on a given line.

To use this option, first select the line whose shear force and bending moment you wish to display.

Next, while holding down the Shift key select the point on the line where you wish the shear force and bending moment. This must be either the end point of a line or an explicit point drawn in your model.

Now select the Analysis / Shear/Bending Moment menu option.

You will see the Shear Force / Bending Moment Dialog Box.

These quantities may also be accessed using the following functions:

shear(point1,line1)
shear(line1,pont1)
moment(point1,line1)
moment(line1,point1)

Force on Pin

Use this option to derive the force transmitted through a point of the model.

The total force at a point in equilibrium is of course zero (unless the point has some external forces applied to it.)

What we need to ask for is the force applied to a given point regarded as part of some sub-component by the other components in the drawing.

To use the Force on a Pin option:

1. Select the geometric entities which make up the sub-component whose forces you wish to examine.
2. Pick Analysis / Force on a Pin.
3. Click on the particular point whose force you wish to examine.

**Derive Accelerations**

If you have a model with masses and applied forces, you can tell Analytix to free up one or more dimensions. It can then compute the instantaneous acceleration in the free dimensions caused by the applied forces.

To use this option, first ensure that appropriate masses are entered into the system. (Without masses, no acceleration will be computed). Then select the dimensions which are free to move. Then select the **Analysis / Derive Accelerations** menu option. You will see the Hourglass cursor while the accelerations are being computed, then the hourglass will disappear.

If you now double click on one of the free dimensions, you will see the Dimension Dialog box. The acceleration in this box will be the acceleration of this dimension caused by the applied forces.

If you double click on a point you will see its instantaneous acceleration due to the applied forces. If you double click on a line you will see its angular acceleration due to the applied forces.

**Dynamic Simulation**

To specify a dynamics simulation, you need to select the dimension or dimensions which will be free to move during the simulation. Then you should select **Analysis / Dynamic Simulation**.

You will see the Dynamic Simulation Dialog Box which lets you specify the time interval and accuracy of your simulation.

**Time**

It is necessary to specify the length of time over which you require the dynamic simulation to run. You specify a start time and an end time. You also specify a time interval at which you wish to record snapshots of the motion.

In the above example, the simulation will run for 2 seconds and a snapshot of the motion will be taken every 0.1 seconds.

It should be noted that this time interval is not the time step-size used by the integration routines. The integration routines calculate their own step size based on how complicated the behavior of the dynamical system is. The integration step size can be much smaller than the interval at which snapshots are saved.

During the integration, a special variable with the name time is kept updated at the current simulation time. You can use this variable to give a time varying force. For example you could set:

\[ f = \sin(2\pi t) \]

and use f as the x component of an input force. This force would then vary sinusoidally with time in the simulation.

Setting a correct value for the variable time is why you need to enter a starting time and an end time for the simulation rather than just a duration.
Choosing a time interval

It is sometimes difficult to know what a sensible time interval for a specific dynamic simulation is.

If you have guessed a too long time interval, you will find that the simulation makes very slow (or even no) progress. This is because Ax has to do a large number of intermediate steps between each captured time step. In this situation, abort and start again with a smaller interval.

If the simulation is proceeding quickly, but the dimension values are not changing much from one interval to the next, you probably have too short a time interval. You can abort and start again with a longer interval.

It is sometimes helpful to do an initial inaccurate model just in order to determine an appropriate time interval. You make the model inaccurate and the simulation faster by setting the relative error high.

Max Iterations

The Maximum Iterations entry allows you to set a maximum for the number of integration time steps you will allow the system to perform. When the system determines it cannot perform the integration without using more than this number of steps, it will halt, giving you a warning message to that effect.

Note that the maximum iterations should be considerably greater than the number of time intervals stored. That is,

Max Iterations > (end time - start time)/time interval.

Relative Accuracy

The relative accuracy entry is the maximum allowable error in dimension values as a fraction of their values. A relative accuracy of 0.005 means that all dimension values throughout the simulation are accurate to within 0.5%.

Error is cumulative through the simulation. Hence the longer the total time interval set for the simulation, the harder it is to maintain a particular level of accuracy and the slower the system becomes.

To speed up the simulation, you can shorten the specified time interval or reduce the accuracy.

Add to Current Simulation

The Add to Current Simulation option lets you continue a previous simulation. The option is only available if a previous simulation exists.

When you select this option, the starting time for the simulation will be fixed to equal the ending time for the existing simulation. The time interval will be set to be the same as the interval for the previous simulation. The end time, maximum iterations and relative accuracy may all be reset.

Send Impulses to Calculator

If your model includes collisions (created by defining Stops between points and lines), then you can elect to send information about the collisions, if they occur, to the calculator.
The information which is sent is the value for the impulse and the closing velocity. For the first collision, the impulse value will be stored in the variable `impulse1`, the closing velocity in the variable `velocity1`.

Subsequent collisions will be recorded as `impulse2`, `velocity2`, `impulse3`, `velocity3`, etc. You can inspect these values by opening up the Calculator Window by selecting **Tools/Calculator**.

The impulse is a measure of force times time and is the integral of the force exerted over the time of the collision. The time of the collision is assumed to be infinitesimally short and the forces to be infinitely large.

The closing velocity is the relative velocity of the point and the line at impact.

**Simulation**

During the dynamic simulation, you will see an Abort box. Click on the Abort button to stop the simulation. The values which have already been calculated will be saved. You can resume computation by clicking on the Add to Current Simulation button of the Dynamic Simulation Dialog box.

You can work in another window while you are performing a dynamic simulation. However, the Ax window is inactive and so may not be reduced in size. In order to select another window, therefore, some portion must be visible before you start your simulation.

**Which dimensions to use**

When you create a dynamic model, most of the dimensions specify constraints which stay fixed throughout the simulation. One or more dimensions, however must be specified as free to move. There are usually a number of different ways to specify the free dimensions. The particular way you specify the free dimensions can affect the efficiency of the simulation algorithms.

For example, a single cylinder engine may be modeled with the piston displacement as the free dimension, or it may be modeled with the crank angle as the free dimension.

The piston displacement does not uniquely specify the configuration of the model, (the crank position could be up or down for any given piston displacement.) This presents a difficulty for the dynamics algorithms at the dead points at either end of the stroke.

On the other hand, using the crank angle as the free dimension in the mechanism uniquely defines it and does not give the simulation any difficulty at the dead points.

A rule of thumb for deciding which free dimensions to use is to use angles in preference to distances and to use distance between point and line in preference to distance between two points or line length.

**Outputs**

The **Graph**, **Table**, **Trace**, **Animate** and **Envelope** tools all have the options to **Use Current Simulation**. With this option selected, these tools output results from the latest dynamic simulation.

For example to create an animation of the last simulation, select **Tools / Animate** and press the **Use Current Simulation** button.
To graph values of some output expression over the course of the simulation, select **Tools / Graph**, press the Use Current Simulation button and enter the desired expression as the y expression.

You can use the **Analysis / Edit Simulation** menu option to select a specific time instant in the simulation to use in the drawing. You may then inspect any of the output variables at that instant, or restart the simulation from there.

**New Simulation**

A playback simulation lets you collect a sequence of drawing configurations, then play them back as an animation, or use the simulation in a graph or table.

It gives you more flexibility than the regular Animate, Graph and Table tools because it lets you vary more than one dimension. It also lets you vary the dimensions by irregular amounts.

To create a playback simulation, you first need to select the dimension or dimensions which will vary in the course of the simulation.

Then you need to select **Analysis / New Simulation**.

You will see the New Simulation dialog box, which lets you set the maximum number of steps which may be saved in the simulation.

When you press **Ok**, you will see the **Edit Simulation** Dialog Box.

To create a simulation, you first change the dimensions to match the first position of your simulation then add this configuration to the simulation.

You then go back and change the dimensions to match the second position in your simulation then add this configuration to the simulation.

You repeat this procedure till the whole simulation is built.

**Edit Simulation**

The **Analysis / Edit Simulation** option lets you create your own playback simulation, or inspect or edit a playback simulation.

The Edit Simulation dialog box contains two list boxes. The left hand list box contains the names of the dimensions which vary in the simulation and their derivatives. The right hand list box contains the values for the quantity highlighted in the left hand list box throughout the simulation. You use this list box to select a time step of the simulation. You may then Insert a step before it, Delete that time step or Use that time step in your drawing.

**Add**

The **Add** button allows you to add a step to the end of the current simulation. When you press **Add**, Analytix will record from the drawing the current values of all the dimensions in the left hand list box and their derivatives. It will add this configuration to the end of the simulation.

**Delete**
The **Delete** button will remove from the simulation the time step highlighted in the right hand dialog box.

For example, to remove time step 3, highlight time 3 in the right hand dialog box (it does not matter which dimension is displayed). Then press the Delete button.

**Insert**

The **Insert** button allows you to insert a step before the currently selected time step in the simulation. When you press **Insert**, Analytix will record from the drawing the current values of all the dimensions in the left hand list box and their derivatives. It will insert this configuration into the simulation before the time step currently selected in the right hand list box.

**Use**

When you press the **Use** button, Analytix will take the dimension values, velocities and accelerations from the simulation for that time step and substitute them into the drawing. This option lets you go to any specific time step in the simulation and interactively make measurements from the drawing.

**Tolerance Zone**

This analysis option draws the region within which the selected point must lie given the existing tolerances on the drawing's dimensions.

Tolerances on distances and angles are displayed using the Attributes / Measure function.

To create a tolerance zone:

1. Enter tolerances for the dimensions in the drawing as appropriate.
2. Make sure that an appropriate point and line are fixed.
3. Select the point whose tolerance zone you wish to display
4. Pick Analysis / Tolerance Zone.

Tolerance analysis can be quite time consuming; so there may be a reasonable lag, then the tolerance zone will be drawn.

If the tolerances are realistically tight, this zone will probably be too small to see with the naked eye and you will have to zoom in to find it.

A technique which is sometimes useful is to scale the size of the tolerances up by an order of magnitude or two, then you will be able to see both the overall drawing and a scaled up version of the tolerance zone.

It is important to make sure you have fixed a point and line when performing tolerance zone analysis, as there has to be a fixed reference with respect to which to measure the variation of the selected point.

**Max / Min Tolerance Zone**

If the current tolerance mode is **Max/Min Tolerance**, then the tolerance zone is a polygon. This polygon is the locus of all the positions attainable by the point for within-tolerance values of the
Statistical Tolerance Zone

The Statistical Tolerance Zone is an ellipse.

There are several different ways of describing this ellipse. The most succinct is its mathematical definition: it is an equiprobable ellipse of the Bivariate Normal Distribution which describes, statistically, the position of the point.

This gives you the shape of the region where the point will lie "most of the time". The definition of what is meant by "most of the time" depends on the statistical interpretation of the tolerances which were given for the dimensions.

When you use the Statistical Tolerancing mode, Analytix interprets the upper and lower tolerances as being fixed percentiles of a Normal Distribution. For example you might regard the input tolerances to be 99.9% percentiles - i.e. failure to meet tolerance on a given dimension will occur only 0.1% of the time. In this case the ellipse shows a region inside which the point will lie 99.9% of the time.

If you interpret the input tolerances to be 95% percentiles, then the output tolerance zone must be interpreted as the region inside which the point will lie 95% of the time.

Erasing Tolerance Zones

Tolerance zones are drawn on the Background level. You erase them using the Edit / Erase Background menu option.

Tolerance Trace

The Tools / Tolerance Trace option lets you look at the tolerance on an entire coupler curve.

Instead of a single curve, the tolerance trace gives two curves which represent the boundaries of the region where the trace point may lie throughout the motion.

This region will be either statistical or absolute depending on which default tolerance flags are set.

Toolbar Help

Select - Select entities in the drawing

Point - Create point
Line - Create line
Circle - Create circle
Arc - Create arc
Construction Line - Create construction line
Line Length - This dimension lets you specify the length of a line.
Parallel Distance - This dimension lets you specify that two lines are parallel.
Line to Point - This dimension lets you specify the perpendicular distance between a line and a point.
Point to Point - This dimension lets you specify the distance between two points.
Angle - This dimension lets you specify the angle between two lines.
Radius - This dimension lets you specify the radius of an arc or circle.
Tangent - This lets you specify that a circle or arc is tangent to a line or to another circle or arc.
Point on Line - This lets you specify that a given point lies on a given line.
Point on Circle - This lets you specify that a given point lies on a given circle.
New - Creates a new file with no name and no contents. Erases the current drawing.
Open - This menu option allows you to open a previously saved Analytix file.
Save - This menu option saves the current drawing in a file.
Cut - This option Cuts the currently selected entities and any dependent entities from the drawing
Copy - This option copies all currently selected entities to the clipboard.
Paste - This option allows you to Paste that drawing on the clipboard onto your current drawing.

Undo - Reverses actions starting with the last one.

Redo - Reinstates actions that you have undone.

Print - Brings up the standard system Print dialog box so you can choose a printer and print options.

Help - Invokes the embedded Help facility.

New Features

Screen Capture
In the Edit menu. Analytix once again allows part or all of the window to be copied to the clipboard as a bitmap image.

Calculator Variable Sorting
At the bottom of the calculator window, there is now a Sorted checkbox that toggles alphabetical sorting for calculator variables.
Angle Dimensions
Angle dimensions can now be dragged to adjust its position in the drawing, just like other dimensions.

PDF Export
This renders the currently visible part of the display to pdf format.
Level Improvements
In addition to the existing level dialogs, there is now a modeless Level Manager dialog that can be used to switch levels, toggle level visibility, and rename levels.

The current level can also now be set via a combo box on the taskbar, and selected entities can be assigned to a level through the right-click context menu.

Toolbar Configurations
On startup, Analytix now puts your toolbars back where you left them.

Multivariate Iteration Improvements
Multivariate iteration problems can now be

- named, saved, and restored using the new Iteration Manager dialog, available in the Tools menu.
- solved over DDE.

A non-active iteration problem can be solved by passing “solve('problem name’)” to Excel’s DDE Execute function. Calculator statements can be executed in this way as well.

Variable Masses
Masses can now be defined as arbitrary expressions, not just numeric literals.

Annotation Improvements
The Annotation dialog is now modeless – clicking on an entity when the keyboard focus is in the annotation text box will now insert the identifier for that entity into the box.

There is now an Align Annotations tool, available in the Tools menu when multiple annotations are selected. This automatically spaces and aligns the selected annotations, aligning to left, center, right, or the position of the first variable reference.

DDE Link Editing
A new Edit menu option lets you edit your incoming DDE links. If you have moved the path to the linked program or changed a file name, it is easy to edit the links and reconnect.
Index

- A -

Accelerations
   Derived 74
Actuator 70
Add
   Force / Torque 69
   Load 69
   Spring / Damper / Actuator 70
   Stops 71
Alignment
   Annotations 61
   of drawing with gravitational field 43
Analysis
   Stress & Deflection 72
Analysis Menu
   Add Actuator 68
   Add Load 68, 69
   Add Spring / Damper / Actuator 70
   Add Stops 68, 71
   Derive Accelerations 68, 74
   Dynamic Simulation 68, 74
   Edit Simulation 77
   Edit Stops 68
   Force on a Pin 73
   Force on Pin 68
   New Simulation 68, 77
   Resultant Force / Torque 68, 72
   Shear / Bending Moment 68
   Shear force / Bending Moment 73
   Stress 68
   Tolerance Zone 78
   Tolerance Trace 68, 79
   Tolerance Zone 68
Angle Dimension 27
Animate 45
   Envelope 46
   Increment 45
   Trace 46
Annotation 23

Annotations
   Align 61
   Arc 22
Attributes
   Font 67
   Info 63
   Measure 66
   Pen 67
Automatic Dimension 25, 29

- B -

Background 20
Bar Properties 41
Bending Moment 73
Blank 34
   Blank / Unblank Level 35

- C -

Calculator 46
   Expressions 48
   Functions 48
   Mass / Weight 55
Circle 23
   coefficient of restitution 71, 72
Colinear lines 29
   collisions 71, 72
   consistantly dimensioned 25
Constrain Menu 29
   Fix Point / Line 30
   Horizontal 31
   Same Line 29
   Same Point 30
   Vertical 31
Construction Line 23
Copy 16
   cross sectional area 72
Cut 16

- D -

Damper 70
DDE 18, 19
- Index -

Defaults Menu 36
- Bar Properties 41
- Default Pen 37
- Default Tolerance 42
- Dynamics 43
- Max / Min Tolerance 41
- Pic Aperture 38
- Statistical Tolerance 42
- System Defaults 38
- Units 39
- Delete 17
- Dimension
  - Info dialog 63
- Dimension Menu 25
  - Angle 27
  - Automatic 29
  - Line Length 26
  - Line to Point 27
  - Parallel Distance 26
  - Point on Circle 28
  - Point on Line 28
  - Point to Point 27
  - Radius 28
  - Tangent 28
- DXF
  - import 12
  - output 12
- Dynamic Simulation 74
- Dynamics
  - Defaults 43
- - E -
  - Edit
    - Stops 72
  - Edit Links 19
  - Edit Menu 13
    - Copy 16
    - Cut 16
    - Delete 17
  - Edit Links 19
  - Erase Background 20
  - Export Link 18
  - Group Selected 20
  - Import Link 18
  - Paste 17
  - Redo 15
  - Screen Capture 20
  - Select 15
  - Select All 15
  - Undo 14
  - Ungroup Selected 23
- Envelope 46
  - Erase Background 20
  - Export Link 18
  - Expressions 48
- - F -
  - File Menu 8
    - DXF In 12
    - DXF Out 12
    - Export PDF 12
  - New 9
  - Open 9
  - Print 11
  - Save 10
  - Save As 10
  - Fillet 22
  - Fix Point / Line Constraint 30
  - Font 67
  - Force
    - on a Pin 73
    - Shear 73
  - Force / Torque
    - applied 69
    - Resultant 72
  - Forces
    - gravitational 43
    - on an inclined plane 43
    - resultant 43
  - Functions 48
    - Alphabetized 51
    - Catigorized 49
- - G -
  - Graph 60
Gravitational Forces 43
Group 20
  Info dialog 65

- H -
Help System and how it works 7
  Linked Text 7
Horizontal Constraint 31

- I -
Import Link’ 18
Increment through an animation 45
  Info
    Dimension 63
      Group 65
    Line 64
    Point 64
  Info dialogs 63
  Iteration
    in Graphs & Tables 59
    Manager 59
    Multivariate 56
    Multivariate over DDE 60
    Univariate 56

- L -
Level
  Blank / Unblank 35
  Change 34
  Manage 35
Line 22
  Info dialog 64
Line Length Dimension 26
Line to Point Dimension 27
Links
  Edit 19
  Export 18
  Import 18
  locus 46

- M -
Mass / Weight Calculator 55
Measure 66
  Tolerance Sensitivity Analysis 66
Menus
  File 8
  Index 7
modulus of elasticity 72
Move Selected 32
Multivariate Iteration 56
  in Graphs & Tables 59
  over DDE 60

- N -
New File 9

- O -
Open an .ax file 9
Output
  Graph 60
  Table 61

- P -
Parallel Distance Dimension 26
Paste 17
PDF Export 12
Pen
  assignments 67
    Default 37
Pick Aperture 38
Plot 11
Point 21
  Info dialog 64
Point on Circle Dimension 28
Point on Line Dimension 28
Point to Point Dimension 27
Points
  Mass / Weight Calculator 55
- R -
Radius Dimension 28
Redo 15
redundant dimension 25
restitution coefficient 71, 72
Resultant Force / Torque 72
Resultant Forces Calculation 43
Rotate Selected 33

- S -
Same Line Constraint 29
Same Point Constraint 30
Saving an .ax file 10
Screen Capture 20
Select 15
Select All 15
Annotations 16
Dimensions 16
Force Elements 16
Geometry 15
Shear force 73
Simulation
Dynamic 74
Edit 77
New 77
Sketch Menu 21
Annotation 23
Arc 22
Circle 23
Construction Line 23
Fillet 22
Line 22
Point 21
Spring 70
Stops
Add 71
Edit 72
Stress & Deflection 72
System Defaults 38

- T -
Table 61
Tangent Dimension 28
Tolerance
Analysis 66
Default 42
Max / Min 41
stack up 66
Statistical 42
Trace 79
Zone 78
Toolbar 79
Tools Menu 44
Align Annotations 61
Animate 45
Calculator 46
Envelope 46
Graph 60
Increment 45
Iteration Manager 59
Mass / Weight Calculator 55
Multivariate Iteration 56
Table 61
Toolbox 62
Trace 46
Univariate Iteration 56
Trace 46
Truss analysis 72

- U -
Unblank All 34
Undo 14
Ungroup 23
Units 39, 43
Univariate Iteration 56

- V -
Vertical Constraint 31
View Menu 32
Blank 34
View Menu 32
  Blank / Unblank Level 35
  Change Level 34
  Manage Levels 35
  Move 32
  Rotate 33
  Unblank All 34
  Zoom Box 33
  Zoom In 34
  Zoom Min / Max 34
  Zoom Out 34

- Z -

Zoom
  Box 33
  In 34
  Min / Max 34
  Out 34